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Welcome to WINCheckIt's Help System, which is divided into the following parts:

Introduction
Gives a brief overview of WINCheckIt and its capabilities.

Program Operation
Provides a complete explanation of all the WINCheckIt functions.

Frequently Asked Questions -- FAQs
This topic may help you solve some problems that have already crossed TouchStone’s 
Technical Support help desk.

Accessing TouchStone Support Information
If you need to reach TouchStone, contact information is provided. 

Exiting WINCheckIt
When you are ready to leave WINCheckIt...



Introduction

WINCheckIt is an all-in-one Windows problem solver. WINCheckIt is a comprehensive tool for 
use with your PC that allows you to troubleshoot PC problems, clean up disk space, resolve 
setup conflicts, free-up Windows memory, analyze system performance and rescue startup 
and INI files.

Now Windows 95 and Windows 3.1 compatible, WINCheckIt provides an easy-to-use 
graphical interface that allows you to optimize your Windows system's capabilities by 
providing you with a comprehensive set of utility and troubleshooting tools.

· an improved version of its Uninstall utility that includes an archiving feature
· a CD-ROM MPC compatibility test to determine which level of the MPC specifications your system 

meets
· a four-volume technical reference library from McGraw-Hill on CD-ROM
· a modem troubleshooter
· an improved Clean & Zip utility for easy archiving on your system for Windows 3.1 and Windows 95
· new multimedia benchmarks for Windows 3.1 and Windows 95
· a system monitor that tracks the hardware and performance changes in your system
· a memory optimizer that consolidates Windows memory fragments
· a system file editor that enables you to selectively edit or restore data from prior versions of vital 

system files
· an extensive menu of testing and analysis features



Program Operation

WINCheckIt comes with a comprehensive set of diagnostic and troubleshooting features as 
well as a number of handy utilities to manage your system.

WINCheckIt Main Window
Contents of the Main Window 
Changing Resource Monitor Settings
Using Large Fonts with a Resolution Greater Than 640x480?

Analyzing Your System

Gathering System Information
Collecting Data
Loading Data Collection Files (CKD Files)
Viewing Configuration Data
DOS & Windows Environment Information

Troubleshooting Your System
Tracking System Performance
Finding System Changes
Testing Your System
Displaying System Reports
Receiving On-Line Help

Tools
Uninstalling Applications
Clean & Zip
Memory Tune Up
System File Editor
Setup Advisor
Software Shopper

Extras...
Viewing the Technical Reference Library
Creating a Rescue Disk
Removing WINCheckIt From Your System



Contents of the Main Window
When you enter WINCheckIt, the main window appears with the following items:

System Summary
The main window displays an overview of your machine’s configuration. This summary will 
only appear after you have performed a data collection or loaded a previously created data 
collection.    In other words, if you open WINCheckIt using the "No data" option, this 
information will not be displayed.

The following system details are provided:

Processor
Identifies the type of processor and its speed.

NOTE:    If WINCheckIt does not properly recognize the type or speed of the processor, check TouchStone's BBS 
(Bulletin Board System) for an updated CKDATA collection applet.    You can check your CKDATA version number 
using the Versions command under the Help menu.

Math Co-processor
If your PC has a math co-processor (also called a Numeric Processing Unit or NPU) or an 
integral math co-processor, it will be noted.

Bus
Shows the type of bus as well as the types of peripheral slots supported by your 
motherboard, and if your system has SCSI (Small Computer System Interface) support.

System Memory
The total system memory is displayed in megabytes (MB).
 
BIOS
The manufacturer and type of BIOS (Basic Input-Output Service) information is displayed.    
BIOS is where the details about your system is stored.

Hard Drive(s)
The storage capacity for the first two physical hard drives directly attached to your PC. The 
size displayed is the actual size of the hard drive and does not reflect any use of software 
compression programs.

Floppy Drive(s)
Shows the size and density capabilities of your floppy drives (e.g. 360K, 5.25" and 1.44Mb, 
3.5").

Serial and Parallel Ports
The number of Serial (COM) and Parallel (LPT) ports are listed. Unlike many system 
information packages, WINCheckIt identifies the number of serial and parallel ports by 
testing the hardware, not by using the BIOS table. Programs that rely on BIOS often 
misidentify the number of COM and LPT ports.

Mouse and Sound
The type of mouse is provided along with whether or not you have a sound card.    If you do, 
the type will be displayed.

Video Adapter
Identifies the active video mode your PC is using or the maximum VESA mode that your 



graphics card is capable of.

Additional Devices
Identifies additional devices (external and internal) installed on your system. These include:   
CD-ROM drives and Modem/FAX devices.

NOTE:    If WINCheckIt does not detect the presence of your modem, check TouchStone's BBS (Bulletin Board 
System) for an updated CKDATA collection applet.    You can check your CKDATA version number using the Versions 
command under the Help menu.

Resource Monitor
In the bottom left of the main window, WINCheckIt monitors your systems Largest Memory 
Block Available, System Resources Free, Free Memory Below 1MB and the Disk Spaced Used. 
Each of the four readings are graphically displayed in the form of a half-moon graph showing
the actual usage in relation to the total amount used.
 
In Windows 95, the items in the Resource Monitor change to provide more relevant Windows 
95 information.    WINCheckIt monitors your systems CPU Usage, Swap File Usage, Free 
Memory and Disk Space Used.
 
To change the hard drive being monitored or to update the frequency in which WINCheckIt 
displays your system resource, see Changing the Resource Monitor Settings.

Changes Detected Indicator
This indicator lets you know if any aspect (e.g., Hardware, System Files, and Performance) of
your system has changed between (previous -vs- current) data collections. WINCheckIt does 
this by comparing two CKD files to spot any differences.    When you open WINCheckIt and 
choose the Load Previous button, the Changes Detected? indicator displays the differences 
between the last two CKD files.
 
If the indicator is green, then no changes have occurred.    If the indicator is red, then some 
kind of change has occurred.    You can click on the appropriate indicator button to receive a 
breakdown of what the change involves.    The indicator remains dimmed (grayed out) until 
you have performed at least two data collections that can be compared.

In the Windows 95 world where Plug-and-Play can randomly re-assign things like your IRQ 
settings, you definitely want to keep an eye for any changes that may appear here.    In this 
example, if Plug-and-Play adjusts you IRQ settings, it may cause a device to have a conflict 
with another, rendering one or both of the devices inoperable.

The platform that the performance benchmarks was collected in (DOS or Windows) is 
displayed under the Performance button.    This is the platform shared by both CKD files.    If 
you have just collected data but have not yet run the Multimedia Benchmarks utility, only 
DOS benchmarks (run during the data collection) can be displayed.

Status Bar
The file information area, located in the upper half of the main window, displays the file 
name, user name, method of collection, date of the collection, and the collection description 
for the CKD file that is currently loaded.

Function Description
As your mouse cursor passes over the toolbar buttons (e.g., CD-ROM, Collect, Memory, etc.),
a description of each button is given.

See Also:
Changing the Resource Monitor Settings





Changing Resource Monitor Settings
WINCheckIt allows you to change the hard drive being monitored and the frequency with 
which WINCheckIt updates your system resources.
 
To change the resource settings:
 
1. Select the Resource Options command from the File menu.    The Resource Options 

dialog box appears.
 
2. Choose the drive you want from the Selected Drive drop-down list.

3. Enter the number of seconds in the Update Frequency text box.

4. Press the Cancel button to ignore any changes you made.    Press the OK button to 
save your selections.

 



Using Large Fonts with a Resolution Greater Than 640x480

If you are using large fonts with a screen resolution that is greater than 640x480, you may 
have a problem displaying all the information on the Main Window.    This problem arose 
because of the increased amount of information that is displayed on the Main Window.

If you have this problem, go to the Display Font command in the File Menu.

FYI:    This problem only affects the Main Window.    All other windows are designed to support large fonts.
 
 
 



Collecting Data

WINCheckIt uses four mini-applications (applets) -- CKDATA for DOS, WCKDATA for Windows, 
and CMDATA and CKDATA32 for Windows 95 -- to collect specific system and configuration 
information about your PC. Data collection takes between one and two minutes, depending 
on your system’s configuration. The data is stored in a binary file with .CKD extension. This 
binary file can be interpreted by WINCheckIt and other TouchStone products.

To begin the data collection process, click on the Collect button on the toolbar or select the 
Collect command from the File menu.    The Data Collection Screen appears.

NOTE:    You can also perform a data collection using the Collect Now button from the three-option screen when you 
first open WINCheckIt.    Performing a data collection this way, you will not be given the option of which method to 
use.

The Data Collection Screen
You are provided options to designate the collection method and environment.    The 
following elements are found on the screen:

Users Settings
There are certain parameters that would be difficult or impossible to detect about your 
system that are important for system diagnosis.    You tell WINCheckIt whether or not your 
system is a portable computer and if your system is used primarily in a home or office 
environment.    Select which parameters apply to your system.

Description
You can enter any description you want up to 39 characters (including spaces). The 
description is displayed on the main screen and is shown on any report.

Intelligent Mode
If Intelligent Mode is checked and a data collection fails (hangs), WINCheckIt will remember 
which collect hung the system. The next time you enter WINCheckIt, a warning prompt will 
indicate which collect failed and suggest that you perform another data collection.    This 
time, WINCheckIt will intelligently skip over the collect that failed so that your data collection
can finish.    Intelligent Mode is selected by default, and we recommend you leave it 
activated.

Buttons
Select Collect Now to proceed with the data collection process. Select Custom... to go to the 
Custom Settings screen. Select the Options button to access an advanced options screen 
(see Selecting Optional Settings). Select Cancel to exit the data collection screen.

After selecting Collect Now in the Data Collection screen, the data collection begins. Data is 
gathered from Windows first, then WINCheckIt accesses DOS to test the DOS components.

A data-collection-process indicator displays which tests are being run and a percentage of 
their completion.

See Also:
If the Data Collect Hangs



Selecting Optional Settings

The optional settings window lets you choose the DOS Collect Type for your data collection, 
which may be useful when troubleshooting, and advanced user settings that are not covered
in the main data collection screen.

DOS Collect Type
When WINCheckIt performs its data collection, it first detects the Windows 95, then Windows
3.1, then the DOS components of your system. Depending on which data collects you select 
to be run in standard or advanced setting (see Customizing Data Collection), the data 
collection process may incur difficulties when collecting data from the DOS components.

NOTE:    The DOS Collect Type setting only affects the data collection on DOS components. The Windows 
configuration data is gathered first.

When WINCheckIt accesses DOS through a DOS window, some of the multi-tasking 
capabilities of Windows (for example, the ALT-TAB combination) may cause problems 
because WINCheckIt is accessing a single-task environment -- DOS.

Most of the time, the windowed approach will work just fine. But if, for some reason, the data
collection hangs or provides less accurate information, you might try doing the data collect 
using a full-screen DOS window. This eliminates some of the multi-tasking features, 
especially the mouse.

If the data collect still has problems, try the "Drop to DOS" option, which exits Windows to 
perform data collects on the DOS components, then automatically re-enters Windows. Keep 
in mind, this option requires that all other Windows applications be closed so it can close 
Windows.

WARNING:    Do not use the "Drop to DOS" option in Windows 95.

Optional User Settings
Like the User Settings fields in the main data collection window, these two fields -- Vesa 
Local Bus and External Cache -- are items that cannot be detected but do have a bearing on 
your system’s setup and performance.    If you know your system has a Vesa Local Bus, 
select the proper radio button.

Likewise, if you know your system has External Cache, select that radio button.    And if you 
know the amount of cache your system has, select the corresponding radio button: 64K, 
128K, 256K, or 512K.    If you are not sure whether your system has a Vesa Local Bus or 
External Cache, do not select either of the radio buttons.
 
 
 



Customizing Data Collection

When you select the Custom... button in the data collection screen, this Custom Settings 
window appears.    There are over twenty different data collects that are run during the data 
collection process. Here, you may choose which data collects are run as well as the extent to
which the data collect is run (either standard or advanced).

The exclude (Excld.) column allows you to remove a troublesome data collect from the data 
collection process, but this should never be necessary if you leave on intelligent mode.

Note that some diagnostics do not have an advanced capability. This is because there is only
one way to perform the collect.

The method buttons -- Minimum and Advanced -- allow you to control the extent and 
aggressiveness with which WINCheckIt collects data from your system.

WINCheckIt comes with a factory-installed Default Method that will make a deep 
interrogation into your configuration, providing the most accurate results.    However, there 
will be times when you need even more specific data collected, such as complete I/O port 
availability. Collecting this type of data may cause your PC to hang or, at best, will leave it in
an unstable state.

For example, after an advanced data collect on the I/O port, you MUST turn off your machine
for at least ten seconds. This will assure your machine is returned to a stable state before 
attempting to use any programs. For more information, see If Collect Data Hangs.

Advanced
You will want to use the Default Method (with any changes you have saved) as your regular 
data collection routine.

You should not need a more specific data collection than the Default Method provides, but 
you may want more detailed collect for more exact system readings.    In this case, you 
would use the Advanced Method by clicking on the Advanced button.

WARNING:    If you use the Advanced Method and receive the prompt to turn off your system for at least ten 
seconds, make sure you exit Windows first before turning off the power.

Minimum
The Minimum Method does not attempt to use interrogation routines that could cause your 
system to hang or become unstable. This method is similar to those used by other utility 
software programs (e.g., MSD). This method is the safest to use, as it provides the most 
stable collection routine. However, it does not provide the level of information required for 
the analysis, while the Default or Advanced methods do.

We included this option for use by a technician who may need to troubleshoot your system 
and none of the other methods work because your system is not functioning properly. To 
select the Minimum method, click on the Minimum button.

If you are happy with the custom settings you have selected, you may save them as defaults
using the Save button. This means that every time you run a data collection using the 
Custom Method in the method selection box, the data collects that you save as your defaults
will be run.

Once you have customized your data collection process, select OK.





If Collect Data Hangs

It is highly uncommon, but possible, for WINCheckIt to have hardware incompatibility 
problems when collecting data. This is due to the millions of different combinations of 
hardware and software available.

FYI:    One way to tell if your system is hung is to toggle the CAPS LOCK key to see if the light on the keyboard 
changes. If the light does not change, your system is probably hung; if it does change, then the system may still be 
processing.

If you run a data collection using the Default method in intelligent mode, you will never need
to worry about excluding collects if a data collection fails because the intelligent mode will 
record any collects that fail and exclude them automatically when you perform subsequent 
data collections. If you perform a data collection using the Minimum or Advanced method in 
intelligent mode and it hangs, WINCheckIt will exclude the failed collect for the next data 
collection only.

FYI:    If, for some extraordinary reason, the data collection continues to hang repeatedly, despite being in intelligent
mode, there is a method for collecting system details outside of Windows.    You can run the COLLECT.BAT batch file 
from the PROGRAMS subdirectory under the directory where WINCheckIt is installed (as a default, the path should 
be C:\TSC\WINCKPRO\PROGRAMS).    Make sure Windows is not running when you attempt to initiate the 
COLLECT.BAT batch file.    As a last resort, try a clean boot without any device drivers or TSRs, then initiate the batch
file.    To perform a clean boot, press the F5 key while the "Starting MS-DOS..." message appears on the screen on 
systems with DOS 6.0 and above.

Another possibility that you may want to check is the DOS Collect Type in the Optional 
Settings screen. Try a different setting there (for example, switch from Windowed to Full 
Screen or Drop to DOS).

NOTE:    If you receive a "floating point error,"    use the following environment variable in your AUTOEXEC.BAT file:

Set 87=No

See Also:
Selecting Optional Settings
Exclusions



Loading Data Collection Files

With the Load Data command, you can select a data file from any past data collection.    
When you select Load Data, you will see a dialog box to let you select the data file you wish 
to load.      

Note that when you load a new data file or use the    command, any windows in WINCheckIt 
that are currently open will be closed so that you will not be confused in regard to which set 
of data you are viewing.    The exceptions to the windows that are automatically closed are 
the Help, Reference Library, Clean & Zip, Uninstall utility, and Tune Up features because they
do not require or reflect a data file.

The platform column indicates the Method and DOS Collect Type for the past data collection 
(for example, Min/Windowed or Adv/DropToDOS).

The Delete button allows you to remove unwanted data collections.

When you select the CKD file you want, click on OK.

The Cancel button allows you to remove unwanted data collections.

See Also:
CKD Files 
Collecting Data 



Sysinfo Reports

The Sysinfo Reports command provides comprehensive reporting of system information in 
one location.

The system information data is grouped into three reports:    Basic Information, Setup 
Information, and Detail System Information.

Within each report, you can select which information you want to view by checking the 
appropriate boxes.    To include all the available information, select the "All Reports" check 
box at the bottom of the screen.      When you have finished making all of your selections, 
press the OK button to proceed to the WINCheckIt Report Viewer.      

See Also:
Collect Data 
Load Data 
Report Viewer 



Test Journals

Each test creates a Test Journal which shows the results of each step of the test.    Normally, 
tests complete and identify any failures.      However, if system problems prevent a test from 
completing, you can analyze the journal to identify which part of the test caused the more 
drastic failure.    

WINCheckIt always names the Test Journal files with a JNL extension and stores them in the 
REPORTS subdirectory.      When you run a test, the current .JNL (and .RPT) file for that test 
are deleted and new ones are created by the test program.    After the test or tests is 
complete, the WINCheckIt Report Viewer will automatically open to view the report.        If you
wish to save a report for later use, use the Save As command and give the file a new name 
and/or extension.

You can view the latest available journals by selecting the Test Journals command from the 
File menu. 

See Also:
Report Viewer 
Test Results



Test Results

When you run a test in WINCheckIt, a file containing the results of the test is created 
including which test steps passed, which failed, and which were skipped (and why).      

WINCheckIt always names the Test Result files with a RPT extension and stores them in the 
REPORTS subdirectory.      When you run a test, the current .RPT (and .JNL) file for that test 
are deleted and new ones are created by the test program.    After the test or tests is 
complete, the WINCheckIt Report Viewer will automatically open to view the report.        If you
wish to save a report for later use, use the Save As command and give the file a new name 
and/or extension.

You can view the latest available results by selecting the Test Results command from the File
menu. 

See Also:
Report Viewer 
Test Journals



Exit

Selecting the Exit command from the File menu or the Exit button will close the WINCheckIt 
application.



Viewing Configuration Data

The commands in the SysInfo menu (e.g., Hardware, Network Info, Memory, etc.) will provide
you with specific system configuration details about your machine.      This menu is only 
available after you have collected data or loaded a previous data collection (CKD) file.

The information displayed will familiarize you with what your system has installed and what 
can be added to enhance your machine.      You can also view your CMOS data, check what 
hardware interrupts are assigned to see which are assigned, free, and which indicate 
conflicts, and view the assigned and available I/O addresses.

This information is critical in troubleshooting your system should problems arise.

See Also:
Hardware 
Network Info 
Memory 
CMOS Data 
IRQ/DMA Analysis 
Interrupt Vectors 
I/O Address Map 
BIOS Data 
Hard Drive Table 
Drive List 



Main System Information

When you select Main System from the listbox on the Hardware Details window, the 
following information will be presented:

Computer Type
This is the classification that WINCheckIt gives the computer, based upon the attributes it 
detects. The name includes the machine’s manufacturer and model (e.g., Toshiba T3100) 
when available.

If WINCheckIt cannot determine the exact manufacturer or model, your PC will be labeled as 
one of the following three: Generic AT Compatible, High Performance PC, or Ultra High 
Performance PC.

WINCheckIt's inability to determine the exact manufacturer or model does not indicate any 
problem with the machine, simply that the computer does not respond to that type of 
inquiry. The computer name is merely WINCheckIt’s best conclusion at the machine’s 
manufacturer and model.

NOTE:    If WINCheckIt does not properly recognize the type or speed of the processor, check TouchStone's BBS 
(Bulletin Board System) for an updated CKDATA collection applet.    You can check your CKDATA version number 
using the Versions command under the Help menu.

ID Bytes
These values are reported by the BIOS to help software identify the general class of 
machine.    If the BIOS does not return an ID, WINCheckIt displays "unknown."

Bus
This shows the type of bus installed on your computer, as well as the maximum data width 
for expansion cards (i.e. 8-, 16-, or 32-bit).    If your system has a combination of buses (i.e. 
ISA/PCI), WINCheckIt will show the combination. The standard bus types that WINCheckIt will
identify include ISA, EISA, Microchannel, PCI and PCMCIA.

Processor
This value shows the processor class and its current operating mode.    Processor classes that
run Windows and are identified by WINCheckIt include: 286, 386 (SX, DX, and SL,) 486 (SX, 
DX, DX2, and DX4), Pentium, and P6 (the next generation of the Pentium processor).

NOTE:    WINCheckIt also detects processor chips (clones or proprietary versions) from other companies such as IBM,
Cyrix, and Next Generation.

CPU State
This is the processing state of the CPU when the data was gathered.    Examples include Real
Mode and Protected Mode.    If WINCheckIt was unable to get this information from the BIOS, 
"unknown" will be displayed.

Coprocessor
If the computer has a math coprocessor, this value shows its class and clock speed. Math 
coprocessor classes that operate in Windows and are identified by WINCheckIt include: 287, 
387, 486FPU, and Pentium.
 
Setup Type 
Your computer's setup can be defined using the data stored in CMOS RAM on AT and later 
models.    This field shows which method is being used to store setup information.    Possible 
values are CMOS, none, and unknown.    Unknown is used if the BIOS does not respond to 



this type of inquiry.

Clock
This indicates whether a battery backed-up clock is installed on the computer.    Battery 
backed-up clocks continue tracking date and time after the computer is powered off, thereby
making it unnecessary to re-enter that information every time you boot-up.

NOTE:    The two general types of clocks that WINCheckIt identifies are BIOS-Compatible and CMOS.    All computers 
use a CPU clock that runs off an oscillator powered by the AC power source.    This is the clock that applications 
address when displaying the time and date.    When the computer is turned off, the absolute time is lost.

BIOS Information
These fields display the following data regarding the BIOS (Basic Input-Output Service):

· BIOS Mfr -- Brand name of the BIOS (firmware chip) installed on the computer.

· Size -- Size of the BIOS ROM.    In addition, this helps identify the BIOS version.

· Date -- The BIOS revision date.    Some software applications use this date to 
determine compatibility. WINCheckIt determines the BIOS revision date by reading it 
from the standard location within the BIOS.    Be aware that some manufacturers do 
not keep this information up to date.



Video Information

When you select Video from the listbox on the Hardware Detail window, you will see the 
following information on both the primary and secondary video adapters.    The information 
shown under Video 0 reflects the video attributes for the adapter which was being used 
while data was collected.

RAM Size
Amount of RAM installed on the video card.

Adapter
Type of video card. WINCheckIt identifies the following types of cards:

· MDA -- Monochrome Display Adapter.    This video card can display only text 
characters and only in one color.    This standard supports only monochrome mode 7 
(720x350 pixel resolution).    This card does not support the Windows 3.1 
environment, but may be found as the second adapter.

· CGA -- Color Graphics Adapter.    This video card displays text in any of 16 colors and 
graphics in any of 4 colors.    This standard supports video modes 4 and 5 (320X200 
4-color graphics) and mode 6 (640X200 2-color graphics).    This card does not 
support the Windows 3.1 environment.

· EGA -- Enhanced Graphics Adapter. This video card displays text and graphics in any 
16 colors from a palette of 64.    It supports a resolution of 640x350.    In addition, it 
has the unique ability to support either MDA, CGA, or EGA monitors.

· MCGA -- Multi-Color Graphics Array.    This video card is a cross between CGA and 
VGA.    Specifically, it supports all CGA modes and can display graphics in up to 256 
simultaneous colors.    This type of adapter is built-in on all IBM PS/2 Model 25 and 
Model 30 computers, but it has gained little popularity in favor of VGA.

· VGA -- Video Graphics Array. This video card can display text and graphics in any of 
256 colors from a palette of 262,144.    It also supports a resolution of 640x480, which
is higher than CGA, EGA, or MCGA video cards.    This type of adapter is built-in to all 
mid- to high-range IBM PS/2 Model computers, and most compatibles.

· SVGA -- Super VGA. These cards are VGA-compatible but offer vendor-specific 
enhancements, such as higher resolution (800x600 and sometimes 1024x768 or 
1280X960/1024) and enhanced text modes.

· VESA -- Video Electronic Standards Association.    For this enhanced VGA, a device 
driver must be installed. This video interface standard provides a generic way to go 
beyond VGA. It provides an interface layer on top of another video card already 
installed. The other card must at least support VGA.    Most SVGA cards have drivers 
for VESA.

· XGA -- Extended Graphics Array.    This elevates the extra overhead when updating 
the screen by implementing direct memory aperture technology.    The display 
adapter no longer has to shift to the correct range when reading and writing memory 
as it does with VGA.    The entire screen fits one contiguous range of memory.

Video BIOS
Manufacturer of the video BIOS.



Chip Set
The Chip Set applies to SVGA cards only.    This value is the specific chip set for the SVGA 
card.    Sample values include Tseng Labs and Paradise Labs.    This information may help you
determine compatibility with device drivers and applications.

Max Resolution
Identifies the highest graphics resolution mode supported by the adapter.

 Max Colors
Identifies the highest number of colors supported and associated mode.

Max Text Mode
Identifies the highest text mode supported by the adapter.

Monitor
Identifies the type of monitor connected to the video card.    The monitors supported by 
different adapters are EGA, MCGA, VGA and Super VGA.



Memory Information

When you select Memory from the listbox on the Hardware Detail window, you will see the 
following information:

Physical Memory

· Base Total -- Total amount of memory installed that is directly accessible by DOS, 
often referred to as Conventional memory.

· Base Available -- Amount of base memory currently available.    WINCheckIt 
attempts to show available memory as if WINCheckIt and Windows were not in 
memory.

· Upper Memory Total -- Amount of upper memory (beyond the Base Total memory) 
to a maximum of 1MB.

· Largest Block -- Size of the largest block of upper memory that is available.

· Extended Total -- Total amount of memory above 1MB physically installed on the 
computer.

· Extended Available -- Amount of extended memory available (may be available as 
managed memory).

Managed Memory

· XMS Total -- Total amount of extended memory managed by some type of XMS 
(eXtended Memory Specification) utility.    Note that this memory overlaps the 
physical extended memory described above.

 
· XMS Available -- Amount of XMS memory available.    All PCs must have at least 2MB

to practically and efficiently run Windows 3.1.

· HMA -- High Memory Area.    On machines with more than 1MB of RAM, the first 64KB 
over 1MB is the High Memory Area (HMA).    The HMA is used by XMS to provide extra 
memory to applications that are designed to use this extra 64KB (e.g., DOS 5.0 or 
later).

· Version -- The version number for the XMS driver installed.

· EMS Total -- Total amount of expanded memory (real or managed).    This memory 
may or may not overlap the extended memory area.    

· EMS Available -- Amount of expanded memory available.

· Page Frame -- Amount of memory used by the EMS page frame and the address 
where the memory begins.

· Version -- Version number for the EMS driver installed.



Hard Drive Information

When you select Hard Drives from the list box on the left of the Hardware Detail window, you
will see the following information for the first two physical hard drives directly attached to 
your computer:

Total Size
Physical storage capacity of the drive, excluding the affects of software such as Stacker or 
Doublespace.

BIOS Geometry
Geometry of the drive (cylinders, heads, and sectors) as reported by the BIOS using the 
drive type stored in CMOS (see below).

CMOS Type
A drive table within the CMOS defines the drive types recognized by the BIOS.    Each 
definition includes the number of cylinders, heads, and sectors as well as various other 
information.    You put the correct drive type into CMOS when configuring a PC.

NOTE:    There are some basic limitations that were not covered in the original specification of drive types (usually 
there are 46 drive types).    Type 47 is a user definable type supported by many versions of CMOS.    

Partition
Each hard drive may have up to four partitions.    Each type and size of each partition is 
listed. Examples of partition types are:    DOS 3.31+ Large File System, Novell Netware 
3.11and SpeedStor 16-bit FAT Extended.

A DOS version number followed by a "+," means that the version displayed introduced the 
partition type identified.    This does not indicate the version of DOS installed on the 
partition.

NOTE:    The size displayed is the real size of the hard drive and does not reflect any use of software compression 
programs.



Floppy Drive Information
    
When you select Floppy Drives from the listbox on the left of the Hardware Detail window, 
you will see the following for the first two floppy drives designated in your CMOS memory:

Size
Capacity and disk type (e.g., 1.44Mb, 3.5") of the drive.    If WINCheckIt cannot determine the
exact size of a drive, it will only identify that drive as present.

DOS Name
Logical DOS drive name assigned to the drive (e.g., A:, B:, etc.).    DOS automatically assigns 
each logical drive a name.

Geometry
Number of tracks and sectors the drive can read from or write to, and the number of heads 
on the drive (generally two except for early IBM-PC floppy drives).

Media Support
Types of media supported by the drive.    Possible values include the following:

· Extra High Density -- This is 2.88 MB for 3.5 inch drives;    5.25 inch drives do not 
support extra high density.

· High Density -- This is 1.44 MB for 3.5 inch drives and 1.2 MB for 5.25 inch drives.
· Double Density -- This is 720 KB for 3.5 inch drives and 360 KB for 5.25 inch drives.



COM Port Information

When you select COM Ports from the list box on the left of the Hardware Detail window, you 
will see the following information for the first four serial ports on your PC:

DOS Name
This is the name DOS uses to identify the port.    DOS commonly assigns the names "COM1" 
through "COM8."

I/O Address
The port’s base address (in hexadecimal format).    The hardware interrupt for each port is 
assigned to these base addresses for servicing.

Chip Type
The physical serial chip model.    Examples include "8250" and "16550."    If WINCheckIt 
cannot get the chip type from the BIOS, "unknown" is displayed.

FIFO
Indicates whether or not a FIFO (First In First Out) buffer is supported on the serial port.

Settings
The port’s communication settings: baud rate, parity, data bits, and stop bits.

Most communications and terminal emulation programs will use the base address directly to 
access a serial port, but many other DOS applications will use the DOS name.

Most printer drivers also will use the DOS name. If you have more serial ports than are 
reported, one or more ports may be configured for the same address.    If this happens, you 
must re-configure the "shadow" serial port so that it uses a unique address.

See Also:
Naming convention for COM Ports 



LPT Port Information

When you select LPT Ports from the list box on the left of the Hardware Detail window, you 
will see the following information for up to three parallel ports on your PC:

DOS Name 
Name assigned by the BIOS.    This is the name DOS uses to identify the port.    Unlike the 
case with serial ports, where some software applications access ports using the base 
address directly, the DOS name is commonly used for accessing parallel ports.    DOS uses 
"LPT1," "LPT2," etc. for this purpose. 

I/O Address
The port’s base address (in hexadecimal).    The hardware interrupt for each port is assigned 
to these base addresses for servicing.

Bidirectional
Indicates whether the port supports bidirectional communication.    Bidirectional ports can 
transfer data in either direction on their data lines.    PS/2 parallel ports and newer PC 
compatibles often have bidirectional parallel ports.



Sound Device Information

When you select Sound Device from the list box on the left of the Hardware Detail window, 
you will see the following information for the sound card installed on your machine 
(assuming one is installed, and the driver is loaded properly):

Sound Device
The name of the sound device interface found (if present).

Compatibility
Types of sound device drivers with which the card is compatible.

Features 
WINCheckIt’s best determination of the specific features of the indicated sound device.

Interface
The type of interface for the sound device.

I/O Address
The sound card’s base address.    The hardware interrupt is assigned to this address for 
servicing.

Version
The version of the driver interface.



CD-ROM Information

When you select CD-ROM from the list box on the left of the Hardware Detail window, you 
will see the following information for the CD-ROM installed on your machine (assuming one 
is installed, and the driver is loaded properly):

Interface
If it exists, the CD-ROM interface.

Driver
The name of the software driver program used to access the CD-ROM.

WARNING:    If the CD-ROM driver is not loaded, WINCheckIt Professional will not find the CD-ROM device.

Version
The version of the software driver.

DOS Name(s)
The logical DOS drive name assigned to the CD-ROM (e.g. D:, E:, etc.).    DOS automatically 
assigns names to the logical drives and different names (letters) to the hard drives, floppy 
drives, and CD-ROM drives.



Input Device Information
    
When you select Input Device from the list box on the left of the Hardware Detail window, 
you will see the following information for your system's keyboard, and mouse:

Keyboard
The type of keyboard currently connected to the computer, as well as the settings of Num 
Lock, Caps Lock, and Scroll Lock at the time the data was collected.

Mouse 
The type of mouse (if any) currently connected to the computer, its speed setting (slow, 
medium, or fast), and the revision number for its driver.

WINCheckIt identifies the following types of mice:

· Serial -- Connects to the serial port and uses a hardware interrupt (IRQ).
· Bus -- Connected to a special card that must be installed specifically to support it.
· PS/2-Style -- A built-in bus mouse found on PS/2 computers.

 



CAS FAX Information

When you select CAS FAX from the list box on the left of the Hardware Detail window, you 
will see the following information for your system's CAS compliant FAX card:

Model
The manufacturer of the FAX card.

CAS MUX
The MUX (multiplex) address within the CAS driver.

CAS Revision
The revision level of the CAS driver software.    This value is useful when troubleshooting FAX 
card problems.

Sender
Name of the sender that is currently defined for the FAX. This value is entered by the user 
during the FAX software driver setup.

CAS Path
The full path on the computer where the CAS driver is located.

Phonebook
The phone book file the FAX driver software uses.

Logo
Path and file name of the Logo file.    The Logo is the PCX format graphic file included on the 
cover page (if specified).    It is limited to 1700x800 pixels (about 8.5" wide by 4" long).

Software
Software reported by CAS as associated with the driver software.

Speeds
The BAUD rate the FAX card is able to send and receive data.

NOTE:    In order for a CAS-compliant FAX board to be detected, the FAX software driver must be loaded in memory.   
WINCheckIt detects FAXes using the CAS driver (the DCA/Intel Communicating Application Specification) standard.



Modem/FAX Information

When you select Modem/FAX from the list box on the left of the Hardware Detail window, you
will see the following information for your system's Modem and Non-CAS compliant FAX card:

NOTE:    If WINCheckIt does not detect the presence of your modem, check TouchStone's BBS (Bulletin Board 
System) for an updated CKDATA collection applet.    You can check your CKDATA version number using the Versions 
command under the Help menu.

Device
In the above example, the "1" after Device indicates that the modem was the first device 
that WINCheckIt found and reported.

Max DTE Speed
This indicates the highest speed that your computer can communicate with the modem.

Port Used
This specifies the port where the modem/FAX is attached.

Port IRQ
This indicates the IRQ designated for the port where the modem/FAX is attached.

NOTE:    During the modem step of the CKDATA data collection process, if the modem is detected but its IRQ setting 
cannot be determined, a minus-one (-1) reading will appear in the Port IRQ field of the Modem/Fax part of the 
Hardware report (access through Hardware command in the SysInfo menu or the Hardware toolbar button).
 
Reasons why a modem might be detected but not its IRQ include the device being in a strange location or sharing 
an IRQ.    As an example, LPT ports typically have an IRQ setting of 5 or 7.    Your modem may also have one of those
two settings.    Because LPT ports are not interrupt driven and allow IRQ sharing, your modem could use the same 
IRQ.    In that event, WINCheckIt would be unable to detect the modem’s IRQ setting and report the minus-one 
reading.

FIFO Buffers
Indicates whether or not a FIFO (First In First Out) buffer is supported on the serial port.

Self Identity Results
WINCheckIt queries the modem/FAX to provide setup information about itself.    The results of
that query are listed here.

FAX Capability
This field indicates whether (Yes) or not (No) the device can act as a FAX.

FAX Compatibilty
This tells the type of FAX device.    The possible values are CAS FAX, Class 1 or 2, SendFAX, or
Unknown.

NOTE:    In order for a Modem/FAX board (excluding CAS-compliant boards) to be detected, the FAX software driver 
must be loaded in memory.



Hardware Details 

With the Hardware command, you can view in-depth details on major system components 
for your system.    To view details about your system, select the Hardware command from 
the SysInfo menu or click the Hardware toolbar button.    The Hardware Detail window 
appears.

Data for your PC's Main System is automatically selected when the Hardware Detail window 
first appears.    On the left side of the window, the hardware components list box allows you 
to see more data about your system's hardware components. On the right side of the 
window, data relevant to the component selected is displayed.

To view configuration data for any system component installed on your machine, select the 
component you want to see. Depending on the types of components you have installed on 
your machine, and/or selected in the Data Collection window, you can choose from the 
following items:

Main System 
Video 
Memory 
Hard Drive 
Floppy Drive 
COM (Serial Ports) 
LPT (Parallel Ports) 
Sound Device 
CD-ROM 
Input Devices 
Modem/FAX 
CAS FAX 

Note that data for your PC's Main System is automatically selected when the Hardware 
Detail window first appears.



Network Information 

Assuming you are connected to a network, the Network Information Command displays all 
relevant information about your machine with respect to a network to which it is attached.     
The following information will be displayed:

Server

· Current Server--Name of the server to which the workstation is attached.

· Network Type--Type of network to which the workstation is attached.

· Revision Date--Revision date of the network driver.

· Serial Number--Serial number of network server software.

Workstation

· User ID--Network login ID for your workstation.

· Login Time--Time when you logged into the server for the session.

· Connection--Connection number for your workstation.

· Node Address--Address that the network has assigned to your workstation.

· Shell Version--Version of the shell software on your workstation that provides the
communications link between DOS and NetWare (Novell Specific).

· IPX/SPX Version--Version of the IPX/SPX running on your workstation.    This is 
the inter-network packet exchange installation to the particular network interface 
card on your PC (Novell Specific).

· Network Card--Name of the network card installed on your workstation.

· Configuration--Configuration of the network interface card which includes the 
hardware interrupt (IRQ) reported by the interface card, the Base I/O address, and
whether the card uses DMA or internal RAM.



Memory 

The Memory function on the SysInfo menu allows you to view information about the 
computer’s memory usage.      There are four options for viewing memory information, 
including    Base/Upper, Extended (XMS), Expanded (EMS), and Windows.

The information shown in the Memory screens is how memory looked (DOS and Windows) 
when the data was collected on your machine--not as of now.      Below are the four memory 
detail screens available.      To switch between them, press the button labeled with the type 
of memory you wish to view.

Base Memory
The Base Memory screen shows the full 1MB of DOS Memory in both graphic and text form.   
It is divided into two primary areas:    base and upper memory.      As you progress along the 
graphic representation of the DOS    memory area from Base to Upper memory, a "Summary"
list    of the full DOS memory region is presented as well as    the "Notes" list box with specific
information about the    area to which you are pointing.      

Extended (XMS) Memory 
The Extended Memory or XMS menu option shows XMS memory usage.      Extended memory
is simply the physical memory above 1MB while    XMS is the logical allocation of that 
memory according to the eXtended Memory Standard.    Because this function really 
measures XMS usage rather than raw extended memory, it works only when HIMEM.SYS or 
an equivalent    driver for XMS is installed.    

Expanded (EMS) Memory
Like XMS memory, EMS-managed memory doesn't have physical    addresses.    Instead, its 
address space is allocated logically, using handles that point to addresses that can change 
as    necessary.    The bar at the top of the Expanded Memory (EMS) Memory Map screen 
represents this logical space.      

Windows Memory
This screen will show you how memory is being used by Windows.    The blue bar at the top 
of the screen shows how much physical memory your machine has compared to the size of 
the 386 Enhanced Mode swap file.    You will also be shown whether your swap file is 
permanent or temporary, the amount of system resources being used, and amount of 
memory available after the resources are used.

For more details on how memory works, see A Discussion on Memory.

 



A Discussion on Memory

The Intel 8088/8086 microprocessor used in the early PCs and XTs was based on an internal 
16-bit bus and allowed only 20 bits for addressing memory.    Therefore, DOS was written to 
support 20-bit memory addresses.    That means it can deal with only 2 to the 20th or 
1,048,576 bits (commonly referred to as 1MB) of memory.    This limitation has been 
propagated because of the need for downward compatibility.

So, while the 80286 processor allows for a 24-bit address space and the 80386 and 80486 
processors allow for 32-bit memory addressing, they are generally used in a compatible 
manner with the 8086 and DOS still maintains the 1MB memory addressing    limit.

Base Memory
When DOS was created, it was assumed that 640KB was the largest amount of memory 
needed to run any application. Base or conventional memory was defined as the 640KB 
memory used by applications.    Ironically, DOS itself took up some of this base memory.

Upper Memory Area and UMBs
The space between the 640KB and 1MB (384KB) was to be used "expansions" such as video 
cards, network, hard drives, and other add-ons.    This 384KB is referred to as the Upper 
Memory Area.

The original PCs reserved the top 64KB of this region for ROM-BIOS (Basic I/O System), read 
only memory that provided power-on-tests, bootstrap firmware, and standard software 
interfaces to hardware components such as video display, keyboard, and diskette controller.

As systems progressed, the ROM-BIOS was extended from 64KB to 128KB.    Video graphics 
are handled in this upper memory area as well as other things.

However, there are unused blocks of memory in this area that can be used with the proper 
tools.    These unused blocks in the upper memory region are referred to as UMBs (Upper 
Memory Blocks).    Versions of MS-DOS 5.0 (or higher) and other third party memory mangers
such as Quarterdeck QEMM and Qualitas 386MAX access these UMBs.

Extended Memory
When the 80286 microprocessor was introduced, 24-bit memory addressing allowed access 
to 16MB of memory.    Manufacturers began to add more memory beyond the basic 1MB 
boundary of the original PCs.    This memory was called extended memory.

Practical use of this memory was limited because it could only be addressed through special 
means and was not available to DOS.    Also, only one program could use extended memory 
because, by definition, that program owned all the extended memory available.

Very few applications were written to take advantage of extended memory (specifically, only
RAM disks and disk caches).    This situation was later rectified with the introduction of a 
standard for accessing and sharing this memory called XMS (eXtended Memory 
Specification), which will be discussed below (after Expanded Memory).

Expanded Memory (EMS)
Before 286s were popular, the size of some programs were getting big. So, Lotus, Intel, and 
Microsoft worked together to develop a method for adding memory to any PC. This was a 
result of the enormous popularity of the Lotus 1-2-3 spreadsheet and the need for memory 
in excess of 640KB that many spreadsheets demanded.    The memory became known as LIM
(for Lotus, Intel, and Microsoft) expanded memory.



These companies also developed a standard software interface for this memory called EMS 
(Expanded Memory Standard) in 1984.    To use expanded memory, the application must be 
programmed to use this interface.    When this is done, even 8088/8086 computers can 
address the extra memory.

Extended Memory Specification (XMS)
As mentioned above, the extended memory provided on 80286 and above computers was of
limited use until that memory was managed.    A standard, called XMS (eXtended Memory 
Specification) was written in 1988.    Third-party memory managers became very popular for 
using memory beyond the 1MB boundary.

Why You Need to Know
Because a software driver is needed to manage memory beyond the 1MB boundary, any 
program including WINCheckIt can be fooled about physical memory by what it sees through
the memory management software.

The safest way to find out about your computer’s total physical memory is to remove all 
memory managers before collecting system data (unless a memory manager is managing a 
separate LIM memory board).    This will give you the truest picture of what the system 
contains.    Then, you can reload the drivers and examine memory again.    This will give you 
an indication of what effect the memory management software is having upon the system.

The drivers are loaded in the CONFIG.SYS file.    Commenting them out (adding the letters 
"REM" before the drivers in DOS 4.0 and later) in the CONFIG.SYS file will allow you to boot 
the system without them.    For example, if the computer is using the DOS 6.2 memory 
manager EMM386, change the line in the CONFIG.SYS file that reads:

device=c:\dos\himem.sys

It should read:

REM device=c:\dos\himem.sys

This will prevent the HIMEM.SYS driver from being loaded when the system is rebooted.



TSR List 

The TSR List screen displays all Terminate and Stay Resident programs and drivers loaded 
into memory when the data was collected.    This screen allows    you to see the memory 
address where each TSR is loaded, and how much memory is used.    The list box is 
separated into the Base and Upper Memory areas, and when appropriate, free areas are 
noted, so upper memory can be used rather than valuable base memory.      

The following information is displayed in the list box:

· Memory Location -- The starting and ending memory locations for the indicated driver 
or TSR.

· Size -- The size in memory allocated to the indicated driver or TSR.
· Description -- A description of the indicated driver or TSR.      The environment space 

for various TSRs or drivers are also displayed.

See Also:
Memory 



CMOS Data 

The CMOS Data function allows you to view your system's CMOS information.      Keep in mind
that the CMOS file you are viewing is extracted from the data file you have loaded.    To 
ensure that you have a backup copy of your CMOS information, use the Rescue Disk 
command under the DOS/Win menu.

See Also:
Rescue Disk 



IRQ/DMA Analysis

Hardware devices such as the hard disk, system timer, keyboard, etc. must each be serviced
by a unique hardware interrupt. The IRQ/DMA Analysis command displays the devices and 
software programs that use the computer’s hardware interrupts (IRQs or Interrupt ReQuest 
lines).

In addition, the command displays the DMA (Direct Memory Access) channels that are used 
by some devices to access memory without communicating with the CPU. This method 
enables the device using DMA to operate at faster speeds.

The IRQ/DMA Analysis window displays the sixteen IRQs and eight DMA channels available 
on your computer. Many of these are already in use by the basic hardware and software 
components of your PC.

For some kinds of hardware (e.g. a network card), Setup Advisor can only determine if an 
interrupt is in use when the appropriate device driver is installed and activated. Therefore, 
the IRQ/DMA Analysis data may be incomplete if the appropriate drivers are not installed.
 
IRQ
The IRQ number (0 through 15).

Standard
The normal use of this interrupt. This information provides a comparison to standard usage 
and may or may not match your computer’s actual use of the interrupt.

Status
The status of the interrupt. The values are:

In-Use
The IRQ is being used by the device listed.

N/A
Status is not applicable (used for the <CASCADE> interrupt described below).

FREE
Available (may be used by a device driver not installed when data was collected).

Conflict!
Two or more devices use this IRQ. This conflict can cause problems and should be resolved. 
You should reassign the interrupts until all conflicts are resolved.

Actual Hardware
The hardware device assigned to the interrupt. A few special outputs will be displayed under
the Hardware column of the IRQ/DMA Analysis Screen:

<CASCADE>
All 286 and above PCs use two Intel 8259A interrupt controller chips to detect and process 
IRQs. The second interrupt controller is connected to the first via one of the normal IRQ lines.
This IRQ line is known as the <CASCADE> interrupt.

Software
The software interrupt handler used by this interrupt.



At the top of the table, information will be displayed about devices with no IRQ, if applicable.
It is possible for a device to have an IRQ when running in DOS only and to not have an IRQ 
when running under Windows.    For example, if you collected data on a machine running 
only DOS by using CKDATA, the mouse on this machine will report IRQ usage.
    
However, if you collect data directly from WINCheckIt, it is possible that due to the Windows 
Mouse driver the Mouse will no longer be using the IRQ.    Thus, the IRQ/DMA Analysis will 
report such findings as "Device with no IRQ."

DMA Channel
The number of the DMA channel (0 through 7). Standard usage refers to DMA Channels that 
are always assigned to a certain component. Determined usage refers to DMA Channels that
are detected by Windows as being used by a certain component.

DMA Assignment
The component that is assigned to the DMA channel. For example, DMA Channel 2 is always 
assigned to your floppy drive.

At the top of the table, information will be displayed about devices with no IRQ, if applicable.
It is possible for a device to have an IRQ when running in DOS only and to not have an IRQ 
when running under Windows.

Loopback Plugs
Note that plugging loopback plugs into the serial and parallel ports will prevent possible 
system lockup when the interrupts of those ports are checked during the data collection 
process.      

See Also:
Loopback Plugs 



Interrupt Vectors

The Interrupt Vectors command allows you to view information about your PC's 256    
hardware and software interrupts.      This command is useful for examining how interrupts 
are being used.      Such information can be helpful when tracking down software conflicts, 
particularly those caused by TSRs and other resident programs.      

The Interrupt Vectors window lists interrupts in order by number.      The labels in the 
Interrupt Vector display are described below.

· Int--Interrupt number (in hexadecimal format).
· Usual Function--The normal use for each interrupt.      Notice that several interrupts 

have very specific purposes, while others are either marked "reserved" or are used by 
several common applications.

NOTE: The Usual Function field describes the common use for each interrupt, not how it is currently being used.

· Address--The address to which the vector is currently pointing.    The values shown are 
the hexadecimal segment and offset respectively.

· Points To--The location to which each vector is pointing.      In many cases, the vector 
will be pointing to an operating system component like the system ROM, DOS kernel, or 
COMMAND.COM.      

NOTE: Sometimes the vector will be pointing to a TSR or device driver.



I/O Address Map

The I/O Address Map displays port address assignments for each I/O port and the device 
associated with that port.    Input and output ports (I/O Ports) are used by the processor to 
control many parts of the computer.    Each port is identified    by a 16-bit port number.    This 
port number is used by the processor to identify each port.      

Unknown areas are grouped together since multiple 8-byte unknown increments (the lowest 
granularity of the I/O addresses) may be contiguous.      Thus, large portions of the I/O 
address map will be    occupied by these 8-byte increments.    The information below is listed 
in this screen:

· Start -- The beginning byte in hexadecimal of the I/O address.

· End -- The ending byte in hexadecimal of the I/O address.

· Size (Bytes) -- The size of the I/O address area occupied by this port in bytes (this is
the number of I/O ports used by this device).

· Used By -- The description of the device using these I/O port numbers.

NOTE:    If "<unknown>" is indicated, there may be multiple devices using the port numbers specified.

As mentioned above, increments of 8 bytes are the smallest allowable to set an I/O address. 
It is possible to query an I/O address to see if there may be a device attached, and many 
devices have methods of identifying themselves through port addresses.

Input and output ports (I/O ports) are used by the processor to control many parts of the 
computer.    There are special control chips for many of the hardware devices such as the 
keyboard, the serial ports, the system timers, etc.      These chips are communicated with by 
way of I/O ports.      Each port is identified by a 16-bit port number.      

Certain hardware devices allow the user to set switches to determine the I/O port.      Network
cards, for example, can be set to a particular I/O address.      It is important to be able to 
determine which addresses are available to avoid conflicts.



Device Drivers 

The Device Drivers command displays information about all device drivers available to DOS. 
Information displayed for each driver includes address, size, name, and technical 
characteristics.      This information is useful for verifying proper installation and for checking 
compatibility.

The DOS Device Drivers screen uses the following labels:

· Seg:Off--This is the driver’s address in memory.    The values displayed are the 
hexadecimal segment and offset, respectively.

· Attr--This is the driver’s hexadecimal attribute.    Meaningful information gleaned 
from this value is displayed under Description/Characteristics.

· Size--Amount of memory used by the driver, if any.

· Name--This field lists the name of each driver, such as COM1 or B:.

· Description/Characteristics--The first line provides a more descriptive name for 
each driver (wherever possible).    The second line lists important characteristics for 
each driver.



BIOS Data    

The BIOS Data function displays the values stored in the BIOS Data Area.    Your system uses 
this area of memory to track the states of system elements, such as the keyboard, video, 
disk drives, and serial and parallel ports.    This information is useful as an easy reference of 
port address values and/or installed hardware and memory sizes.    



Hard Drive Table 

The Hard Drive Table command displays information from the hard drive table stored in the 
CMOS memory of your computer.      This table defines standard hard drive configurations 
that can be installed in, or connected to, your machine.      This information is useful when 
you’re adding a new hard drive, since you will normally need to match the new drive to one 
of these standard types.

NOTE:    Most BIOSs also allow you to add "user-defined" configurations for hard drives that don’t match, or come 
close to matching, the standard types.      As drives get bigger, more and more of them fall into this category.

When you select the Hard Drive Table command, the following information is available:

· Type--These numbers represent standard configurations.

· Size--Physical storage capacity of the drive in megabytes.

· Physical Descriptions--Number of cylinders, heads, and sectors on the drive.    

· Write PreComp--Specifies the cylinder number the densities must be increased to 
when writing to the disk.

· Park Zone--The safe area (cylinder) for the head to position itself at rest.

· Step Rate--The rate at which the head moves from cylinder to cylinder.

· Ctrl Byte--The control byte specified for this drive type.

NOTE: On drives such as IDE, SCSI, and ESDI, the control parameters Write Precomp, Park Zone, Step Rate and 
Control Byte are irrelevant due to the manufacturing differences of the drives.



DOS & Windows Environment Information

With the DOS/Win menu, you can view details about the versions of DOS and Windows your 
machine is using.      

Click on the desired command below for specific help:
DOS - Summary 
Device Drivers 
TSR Listing 
Environment Variables 
Windows Summary 
Device Capabilities 



Windows Summary 

When you choose the Windows Summary command on the DOS/Win menu, a list box will 
appear showing specific information about the version of Windows your machine was using 
when you collected data.

Windows Summary Components
The Windows Summary information is separated into the following categories:

· Version--Information about the version of the Windows program file, its location 
on the hard drive, and other specifications.

· Setup--Information about the location of the Windows files, the operating system 
used, and the various drivers for input and output devices.

· Keyboard--Information about the type of keyboard installed.

· Display--Information about the video system, and its capabilities.

· Mouse--Information about the mouse, its driver, and settings.

· Memory--Information about the mode memory is being run under (e.g. 
Enhanced, 386).

· Devices--Information about the devices installed with the driver loaded.

· Fonts--Information about the fonts that are installed and which are being used as 
default.



Report Viewer

The Report Viewer is used to display, save and print output for various WINCheckIt 
commands.

Report and Journal Files
WINCheckIt names the Test Results and Test Journal files with a filename describing the test 
with the extensions RPT and JNL, respectively (e.g.    CKHD.RPT is a report for the hard drive 
test, CKFD.JNL is a journal for the floppy drive test).    For more information, see Test Results 
and Test Journals.

The Sysinfo Reports command creates three files based on the sections of information 
available: CKBASIC.RPT, CKSETUP.RPT, and CKDETAIL.RPT.        These files are automatically 
placed in the REPORTS subdirectory.    For more information, see Sysinfo Reports.

When you run a test, the current .RPT and .JNL files for that test are deleted and new ones 
are created by the test program.    If you wish to save a report for archiving purposes, you 
must either use the Save As command in the Report Viewer or copy the file using the 
Windows File Manager.

Viewing Files with the Report Viewer
The Report Viewer allows you to view, print, and save the test results and journals generated
by the tests in WINCheckIt.      Whether you are viewing reports or journals, the report viewer 
functions the same.      When you use the report viewer, the most recent report or journal is 
shown.      

The Report Viewer window contains the following features:

· Report:    The program searches for each of the default files (.RPT or .JNL), 
depending on whether you are viewing test results or journals.    If the default file 
for a test is found, the test name appears in the Report drop-down list box.    For 
example, if CKSYS.RPT, CKCOM.RPT, and CKFD.RPT are found, the drop-down list 
will contain System, Serial Ports, and Floppy Disk.

If you run a test (e.g., Floppy Disk test), that test appears in the Report Viewer
window. Other tests which were run at an earlier time are also accessible in 
the Report drop-down list box. To verify the date of the test, look under the 
Information from: or Report Name (i.e., Floppy Disk) located at the top of 
the report.

· Search For:    You may enter a target word or character(s) in this box that the 
Find feature will search for in the report. The default is "Fail," which will lead you 
to where components failed the test.    To change the search target, select the 
current target and type the search target you want.

· Find/Find Next:    The Find button initiates the search for the target text in the 
"Search For" text box. You can also use the Find command on the Edit menu. Once
you initiate the search, the Find button switches to "Find Next."    When you enter 
a new "Search For" text, the button switches back to "Find."

Report Viewer Menu Options
The File menu on the report viewer provides the following commands:

· Open: Presents a standard Windows open dialog box allowing you to find and 



select a file to open.    The default is either *.RPT or *.JNL, depending on if you 
originally selected Test Results or Test Journals.    You can overwrite these defaults 
and find any file.    However, the report viewer will not accept any file greater than 
30K.

· Save As: Allows you to save a copy of the report or journal being viewed.

· Print: Prints the report.

· Close: Closes the Test Viewer window.

The Edit menu on the Report Viewer provides the following commands:

· Copy: Copies the selected text to the clipboard.      You can then place this text in 
another file, such as a report you are writing.

· Find: Initiates the find for the target text found in the Search For box on the report
viewer window.      This command has the same function as the Find button on the 
report viewer window.

See Also:
SysInfo Report 
Test Results 
Test Journal 



Device Capabilities

The Device Capabilities command displays information on all the devices loaded into 
Windows when the data was collected.    This includes the display and all the printers for 
which drivers were loaded.

NOTE:    The Device Capabilities option is excluded from the data collection process by default.    Certain faulty 
drivers cause that collection step to hang.    If it does, contact the driver manufacturer for an updated driver.    As a 
result of the exclusion from the data collection, the Device Capabilities command under the DOS/Win menu will be 
grayed out until you un-exclude that specific collection step.    For more information, see Customizing Data 
Collection.
 
The list box at the left of the window lists all the devices for which drivers have been loaded. 
Select the device you wish to view and the information box on the right lists the following 
information on the device:

General Information
The details in the General Information section provide the numeric availability for devices 
including: 

· Dimensions
· Colors
· Fonts
· Pixels
· DPI (Dots Per Inch)
· Palettes
· Resolution

Other Information
Listed in the Other Information category are the Driver Version and Technology coded 
information,    and support/ability for Clipping Capabilities (CLIPCAPS or CP) and Raster 
Capabilities (RASTERCAPS or RP). The following are explanations for the CP_ and RC_ details:

· CP_RECTANGLE--Whether or not the device can clip to a rectangle.

· RC_BITBLT--Whether or not the device is able to transfer bitmaps.

· RC_BANDING--Whether or not the device requires banding support.

· RC_BITMAP64--Whether or not the device can handle bitmaps larger than 64K.

· RC_GDI20_OUTPUT--Whether or not the device can support Windows version 2.0
features.

· RC_DI_BITMAP--Whether or not the device supports DIB to memory.

· RC_PALETTE--Whether or not the device supports a palette.

· RC_DIBTODEV--Whether or not the device supports bitmap conversion.

· RC_BIGFONT--Whether or not the device supports fonts larger than 64K.

· RC_STRETCHBLT--Whether or not the device supports the StrtechBlt function.

· RC_FLOODFILL--Whether or not the device supports the FloodFill function. 



· RC_STRETCHDIB--Whether or not the device supports the StretchDIBits function.



System File Editor

The System File Editor allows you to view, compare and modify system files used by DOS 
and Windows.    When you collect data on your machine, WINCheckIt automatically saves the
following system files:

· AUTOEXEC.BAT
· CONFIG.SYS
· WIN.INI
· SYSTEM.INI
· PROTOCOL.INI * 

* PROTOCOL.INI will only be found on machines that are running Windows for Workgroups and Windows 95.

NOTE:    Like the Report Viewer, the System File Editor only handles files 30 kilobytes or smaller. 
 
Saved vs. Current Files
The System File Editor will show you two versions (which may or may not be identical) of 
each system file.    Saved system files are pulled from the data collection CKD file you have 
selected.    Current system files are the live files from your local drive, and viewing them 
works in much the same way as the DOS Edit command.
 
Starting the System File Editor
When you select System File Editor, WINCheckIt will bring up a split screen showing the first 
available Saved and Current system files.    The order in which the System File Editor tries is: 
AUTOEXEC.BAT, CONFIG.SYS, WIN.INI, SYSTEM.INI, and then finally PROTOCOL.INI.    For 
example, if the AUTOEXEC.BAT file is missing from the data file, then the System File Editor 
looks to load the CONFIG.SYS file (and so on).    If no system files are found in the CKD data 
file, then only the Current file will be shown in the editor.
 
Viewing a Comparison
When both the Saved and Current files are available, the left edit window will contain the 
Current file and the right window will contain the Saved file.    The System File Editor will 
identify (if any) the differences between the two files in red text below the two file edit 
windows.    The path for the Current file and the description for the data file will be displayed 
above the respective windows.    
 
NOTE:    The description above the Window will be blue for the active window.
 
Previous/Next Arrows
When viewing a split-screen comparison of differences between the Current and Saved 
versions of a file, there is a pair of buttons under both display boxes.    These buttons 
advance the display to the next or previous difference in the active file.
 
For example, if you are viewing the Saved file and there are several differences, clicking on 
the down-arrow button advances you to the next difference, say from #1 to #2 to #3 and so
on.    Clicking on the up-arrow button reverses the direction and advances back through the 
file from #3 to #2 to #1.
 
Since this feature is circular in nature, when you get to the last difference in a file, clicking 
on the down-arrow button takes you to the first difference in the file.    Consequentially, 
clicking on the up-arrow button when you are at the first difference takes you to the last 
difference.
 



Load and Restore
Like any file editor, the System File Editor contains the customary file and edit commands 
(Save, Save as, Undo, Cut, Copy and Paste) for a live (a.k.a. Current) file.      What makes the 
System File Editor unique is the ability to pull a system file from a saved data collection CKD 
file.    While in the editor, use the Load button to select any previously collected data file.    To
take the stored version of a system file and copy it over the live version, select the Restore 
button.
 
NOTE:    The Restore button will only be available when the focus is on a Saved system file.
 
View and Window menus
This menu allows you to select the different system files and the Saved, Current, and (show) 
Comparison views.

File Selection Drop Down List
The various system files may or may not be available, based on the option selected on the 
View menu.    For example, if Saved is checked on the View menu and there is no 
PROTOCOL.INI in the Saved file, then the PROTOCOL.INI option will not be available on the 
Window menu.



DOS Summary

When you choose the DOS Summary command from the DOS/Win menu, a list box will 
appear showing information about the version of DOS you machine was using when you 
collected data.

DOS Summary Components
The DOS Summary information is separated into the following categories:

· DOS Version--Numerical value, version of DOS.

· Comspec--Location of COMMAND.COM.

· Boot Drive--Drive DOS boots from.

· Manufacturer--Company which published DOS.

· DOS loaded in--Memory area where DOS is loaded.

· Last Drive--The assigned last drive DOS will access.

· Available Handles--List of memory handles available.

· Files--Set number for FILES= in CONFIG.SYS.

· Buffers--Set number for BUFFERS= in CONFIG.SYS.

· Share--Whether or not SHARE.EXE is currently loaded.

· Print--Whether or not PRINT TSR is loaded.

· Memory Manager--Names memory managers if loaded.

· Disk Compression--Names disk compression utility if loaded.



DOS Drive List 

The Drive List function displays usage information for disk drives installed in, or connected 
to, your computer.      This information shows you what drives DOS recognizes, what capacity 
they have, and their current usage.      

Drive List Components
The following information is available on the Drive List:

· DOS Name--The logical DOS drive name assigned to the drive such as A:, B:, C: etc.
· Type--The physical type of drive, such as floppy, hard, network CD-ROM, or 

redirected/assigned.
· Size--Physical storage capacity of the logical drive indicated (in megabytes).
· Free--Amount of physical storage space currently available (in megabytes).
· % Free--Overall percentage of physical storage space currently available for the drive.
· Compression--Identified compression utility used such as DoubleSpace or Stacker.



Environment Variables

The Environment Variables screen shows you the set of strings    in DOS    that manipulate 
how your computer is customized.      These are the same strings you will see if you type the 
SET command from DOS.

DOS automatically allocates an area in memory of between 160 bytes and 512 bytes 
(depending on the version of DOS) for environment space.        This space is used for a 
number of things which are defined in the CONFIG.SYS    or AUTOEXEC.BAT files and placed 
into memory during the boot process.      Listed below are examples of what the environment 
space will do for your PC:

· It holds a string showing the place on the disk where COMMAND.COM is stored (using 
COMSPEC).

· It sets what the DOS prompt looks like if different from the default (using PROMPT).
· It can hold a string defining an alternate for COMMAND.COM (using SHELL -- which also 

can be used to increase the environment size).
· It holds a string showing the current path (using PATH).
· It can hold strings which are very rapidly accessible to application programs.
· It can hold a string telling DOS and Windows where to store temporary files (using 

TEMP).



Testing Your System

The Tests Menu provides a core set of diagnostic tests for your PC.      Using the Tests menu, 
you can choose to run the entire set of tests at once or choose the specific test you want to 
run.      Each test generates a report and a journal that may be saved for later report 
consolidation and comparison.      

Click on the desired command below for specific help:
Test Everything 
System Board 
Serial Port 
Parallel Port 
Hard Disk 
Floppy Disk 
CD-ROM
Modem

See Also:
Test Results 
Test Journal 
Report viewer 



Test Everything

The Test Everything command automates the selection of tests from the menu, excluding 
the CD-ROM and Modem tests.      Each test is started automatically, in the order the tests 
are on the menu, which is the order shown below: 

System Board Test 
Serial Port Test 
Parallel Port Test 
Hard Disk Test 
Floppy Disk Tests 

One report and one journal are created when you run Test Everything.    All the information 
from all the tests is placed in these report and journal files; one test does not write over the 
results of the next as in the case when the tests are run separately.

Results from the Test Everything function are automatically written to two files: TEVERY.RPT 
is the report file and TEVERY.JNL is the journal file.      These files are stored in the REPORT 
sub-directory.    

To interrupt the test sequence after it starts, press <ESC>.    This will stop the tests.

See Also:
System Board Testing 
Serial Port Testing 
Parallel Port Testing 
Hard Drive Testing 
Floppy Drive Testing 
Test Results 
Test Journals 
Report Viewer 



System Board Testing 

The System Board Test checks the primary internal components of your computer in the 
manor listed below.      The tests start as soon as you select the System Board Test from the 
Tests menu.    To stop the test at any time, press <ESC>.

Central Processor Test
This test checks several key functions of your machine’s CPU:

General Function
Checks the general, math, and logic instructions of your CPU.    A failure here indicates a 
major failure in your PC’s main processor.

Interrupt Bug
Identifies CPUs that allow interrupts to occur at incorrect times.    This problem is found 
mainly in older 8088 and 8086 CPUs.
 
Multiply Bug
Identifies a problem with 32-bit multiplication on early 80386 processors.

Protected Mode
Checks the ability to function in protected mode.

Numerical Coprocessor Test
These tests verify that your math coprocessor is functioning correctly.    If there isn’t a 
coprocessor installed, this test will be skipped automatically.

Arithmetic
This test asks your math coprocessor to perform a number of simple floating point 
calculations.    Then it compares the actual results with the expected results.    If the numbers
don’t match, an error is reported.

Pentium Divide
This test detects the floating-point division flaw on Pentium chips.    A FAILED result means 
the test encountered the floating-point division error.    The message below the status line 
indicates the condition under which the Pentium Divide failed.

· "Pentium part is flawed.    FPU is disabled." shows up if the processor has flaw and a 
patch program has deactivated the FPU.

· "Floating-point precision error encountered." means the processor has the flaw and 
there is no patch program in place.

NOTE:    If you receive a "floating point error,"    use the following environment variable in your AUTOEXEC.BAT file:

Set 87=No

Logarithmic
This step uses the trigonometric functions available on the math coprocessor by asking it to 
compute a number of tangents.

Comparison
This step verifies that the coprocessor’s floating point comparison operations are working 
properly.



Real-Time Clock Test
The real-time clock test checks whether your machine’s battery backed-up clock is properly 
set and keeping accurate time.    If your system has a CMOS clock, the alarm function will 
also be tested.

Date Compare
Compares the date on the real-time clock to the date on the DOS clock.
    
Time Compare
Compares the time on the real-time clock to that on the DOS clock.

Alarm Function
Tests a non-audible alarm on the CMOS clock hardware.

Elapsed Times
Compares the amount of time elapsed on both the CMOS and CPU clock to see if they are 
keeping time at the same rate.    

DMA Controller Test
The DMA Controller Test checks to see that communication between your CPU and the DMA 
(Direct Memory Access)    controller is working properly.    The DMA controller is responsible 
for transferring data between various devices and your PC’s memory without interfacing 
directly with the CPU.    

Interrupt Controller Test
This test verifies whether your PC’s interrupt controller is operating properly.    This controller
is responsible for "interrupting" your CPU when certain events happen, such as when a key is
pressed or a character is received over a serial port.    Normally, when an interrupt occurs, 
your PC momentarily stops what it was doing, runs a device driver to handle the event that 
generated the interrupt, and then returns to its previous task.

Results from the System Board Test are automatically written to two files: CKSYS.RPT is the 
report file and CKSYS.JNL is the journal file.      These files are stored in the REPORT sub-
directory.    The Test Results report includes information about your system board including 
the types of processor, coprocessor, realtime clock, and the types and number of DMA and 
IRQ controllers.

See Also:
Test Results 
Test Journals 
Report Viewer 



Serial Port Testing

The Serial Port Test option checks up to four COM ports on your PC.      Each register of the 
8250 serial controller chip is tested    and data transmission is tested at different baud rates 
(up to 115K).      This test is helpful if you use a modem, serial mouse, serial printer, or data 
transfer product (i.e.    LapLink).      The serial port test will check for port integrity, general 
operation, and baud rate generation.

This test can be run either with or without a loopback connector (you must run the test from 
the command line with the appropriate switches to use a loopback plug).    Although 
WINCheckIt can still conduct a reasonable test without    a loopback plug, the test is best 
when using the plugs because data is actually sent and received by the port when an 
external loopback is used.    

If there is not a loopback plug connected, WINCheckIt uses the internal diagnostic mode of 
the UART chip to send and receive characters.    While this is an acceptable confidence test, 
it doesn’t test the functionality of the port under real conditions.

Results from the Serial Port Test are automatically written to two files: CKCOM.RPT is the 
report file and CKCOM.JNL is the journal file.      These files are stored in the REPORT sub-
directory.    

To interrupt the test after it starts, press <ESC>.    This will stop the test.

See Also:
Test Results 
Test Journals 
Report Viewer 
Loopback Plugs 



Parallel Port Testing  

The Parallel Port Test option checks up to three LPT ports on your PC.      The test checks the 
internal registers of the UART chip and the entire character set through the parallel port.

This test can be run either with or without a loopback connector (you must run the test from 
the command line with the appropriate switches to use a loopback plug).    Although 
WINCheckIt can still conduct a reasonable test without    a loopback plug, the test is best 
when using a plug because data is actually sent and received by the port when an external 
loopback is used.    

If there is not a loopback plug connected, WINCheckIt uses the internal diagnostic mode of 
the UART chip to send and receive characters.    While this is an acceptable confidence test, 
it doesn’t test the functionality of the port under real conditions.

Results from the Parallel Port    Test are automatically written to two files: CKLPT.RPT is the 
report file and CKLPT.JNL is the journal file.      These files are stored in the REPORT sub-
directory.    

To interrupt the test after it starts, press <ESC>.    This will stop the test.

See Also:
Test Results 
Test Journals 
Report Viewer 
Loopback Plugs 



Hard Disk Testing 

The Hard Drive Test is non-destructive and will not destroy any data on your hard disk.    
Unlike some hard disk diagnostics, WINCheckIt tests the entire disk at the physical level, 
showing problems even on unused areas or non-DOS partitions.

Test Types
When you select the Hard Disk Test from the Tests menu, the first two installed hard drives 
will be selected for testing.    The following tests will be run on the drives:

Controller Test
Checks the physical interface from your computer to your hard disk.

Linear Read
Verifies each track in order from outermost to innermost sector, ensuring that the data on 
your hard disk can be read successfully.

Butterfly Read
This test also reads each cylinder; however, it moves the read/write head back and forth 
from the outermost cylinder, to the innermost cylinder, stressing the seek mechanism to its 
utmost.

Results from the Hard Drive Test are automatically written to two files: CKHD.RPT is the 
report file and CKHD.JNL is the journal file.      These files are stored in the REPORT sub-
directory.    

To interrupt the test after it starts, press <ESC>.    This will stop the test.

See Also:
Test Results 
Test Journals 
Report Viewer 



Floppy Disk Testing 

The Floppy Disk Tests checks the mechanical operation of your floppy drives, as well as the 
media on individual floppy disks.    The tests are non-destructive, and no data will be lost. 

Test Types
When you select the Floppy Disk Test from the Tests menu, the following tests will be run on 
up to two floppy drives:

Media Surface Test
The media surface test will check a specific floppy disk for bad tracks.

Linear Read
Verifies each track in order from outermost to innermost sector, ensuring that the data on 
your floppy disk can be read successfully.

Random Read
This test reads each cylinder much like the linear read test above, except it reads the 
cylinders randomly, much as it would in general operation. 

Results from the Floppy Drive Test are automatically written to two files: CKFD.RPT is the 
report file and CKFD.JNL is the journal file.      These files are stored in the REPORT sub-
directory.    

To interrupt the test after it starts, press <ESC>.    This will stop the test.

See Also:
Test Results 
Test Journals 
Report Viewer 



CD-ROM MPC Testing

The CD-ROM MPC Test performs three main functions: first, measure a system’s MPC 
(Multimedia PC Marketing Council) compliance; second, test the CD-ROM using the test CD-
ROM to determine transfer rate and access time; third, provide detailed information about 
the disk (type, name, number of tracks, total time, total size, total blocks, and more) and the
CD-ROM drive (drive, driver, address, unit number, tray status, and more).

Checking a system's MPC compliance is important because if a CD-ROM has a higher MPC 
Level than your system, the CD-ROM will not run.

To activate the CD-ROM MPC Test, click on the CD Test button in the toolbar or choose the 
CD-ROM command from the Tests menu.

There are three tabs on the main screen: CD-ROM Test, CD-ROM Info, Advanced Info.    The 
CD-ROM Test tab covers the specifics regarding your system’s compliance with MPC 
standards, which are displayed in the MPC Requirements column.    You can click on the three
MPC Level radio buttons to see which item on your CD-ROM drive failed that particular MPC 
Level’s standard.    For example, if MPC Level 2 requires your Video Display Type to be 
640x480x65,536 and your system is at 1024x768x256, then that item would fail and be 
displayed in red.    Consequentially, your CD-ROM drive would fail the MPC Level 2 Standard 
(and Level 3 three as well because it is more stringent and based on Level 2).    It may have 
passed Level 1, but not Level 2.

The CD-ROM Info tab gives detailed information on your CD-ROM drive and the disk itself.    
And the Advanced Info tab displays even greater technical detail about the drive and disk 
geared toward very experienced users.

Recommendations
The Recommendations field displays the steps you can take to upgrade your CD-ROM drive 
to a higher MPC Level (for example, from 1 to 2).

Buttons
There are six buttons that appear in the CD-ROM MPC Test: three are on the CD-ROM Test tab
only and three are accessible regardless of which tab you are viewing.

· Why (CD-ROM Test Tab Only)--Brings up the CD-ROM MPC Test help system.
· Run Test (CD-ROM Test Tab Only)--Initiates the CD-ROM test.
· About (CD-ROM Test Tab Only)--Provides information on your available resources, 

free memory, CPU type, and network connection.    In addition, the revision number of 
the test is given.

· Change CD--If you want to view details about a new disk, you can insert it in your CD-
ROM drive, then click on this button to get the readings.

· Print--Prints a detailed report based on the CD-ROM MPC Test results.
· Exit--Closes the CD-ROM MPC Test.



Modem Testing

The modem test lets you diagnose your internal or external modem, serial communications 
port, and relative performance of the telephone connection.

You can perform remote testing of your modem by dialing up a dedicated WINCheckIt 
number, which is located in the About box in the Help menu and the ReadMe file.    Testing 
requires two modems to be connected so that data can be transmitted.    This assumes that 
tests on your "local" modem have passed.

To run the modem test, click on the Modem button in the toolbar or select the Modem 
command in the Tests menu.    You will receive a Modem Diagnostic dialog that asks whether 
you want to perform a local or remote modem test.

To perform the local test, which checks your modem without making an outside call, click on 
the Local Test button.

Conversely, to run the remote test, which dials a dedicated number at TouchStone to check 
how the modem communicates over a phone line, choose the Remote Test button.

When you select either of the test, the diagnostic will commence.    After the test is 
complete, the test results will appear in the Report Viewer.



Track Performance 

WINCheckIt measures system performance under DOS and Windows.    The DOS benchmarks
are collected when you perform a routine data collection.    The Windows benchmarks are 
gathered using a special Multimedia Benchmark utility.

You can view the results of the DOS benchmarks using the DOS Benchmarks command in 
the Analysis menu.    The Windows benchmarks are accessible through the Windows 
Benchmark command.    You cannot enter the Windows benchmark window without first 
running the Multimedia Benchmark utility.

You will want to follow this process to check your system’s overall performance is Windows 
and DOS:

First, perform a data collection to obtain DOS benchmarks.    At this point, you can enter the 
DOS Benchmarks window and check your system’s performance under DOS.

Second, run the Multimedia Benchmark utility (see Running the Multimedia Benchmarks) to 
gather Windows benchmarks.    This will "attach" the Windows benchmark data to the data 
collection file.    Now you can enter the Windows Benchmark window and view your system’s 
performance.    If you try to enter this window with an old CKD file that does not have 
Windows benchmark data attached to it, you will be compelled to perform a new data 
collection and run the Multimedia Benchmark.    The reason for this is that there could have 
been changes made to your system since the old CKD file was collected (such as swapping 
processors) that could affect the performance.

To prevent you from performing a data collection then not attaching Windows benchmark 
data to the CKD file, WINCheckIt displays a warning prompt if you try to exit the program or 
load another CKD file before running the Multimedia Benchmark utility.

See Also:
DOS Benchmarks
Windows Benchmarks
Running the Multimedia Benchmarks 



Running the Multimedia Benchmarks

WINCheckIt comes with two Windows multimedia benchmarking tools (a 16- and a 32-bit 
version) that test the performance of your system’s CPU/NPU, hard disk, video and CD ROM 
under Windows 3.x and Windows 95.

This utility works in close conjunction with the Windows Benchmarks feature, which is 
accessible in the Analysis menu.    To perform the Multimedia Benchmarks test, click on the 
Bnchmrk button in the toolbar.    A prompt will appear to ask you to specify the hard drive 
and CD-ROM drive to be tested.

Once you have made your selection and clicked on the OK button, the test will commence.    
Different windows will appear displaying the different components being tested.    After the 
test is complete, the results of the test are displayed as the "Current" value in the Windows 
Benchmarks window.    You can also click on the Run button to rerun the test if you do 
something that might affect the Windows benchmark data such as closing an application.

If you have performed a data collection during the current session, you can use the Save 
button to save the Windows benchmark data into that data collection file.    The Save button 
will be grayed out if the CKD file that is currently open was loaded.    In other words, if you 
loaded a previously created CKD file, as opposed to performing a new data collection for the 
current session, you will not be able to save the Windows benchmark data to that CKD file.

If you have performed a new data collection, you can save the benchmark data to that CKD 
file as many times as you would like.    WINCheckIt will overwrite the previous benchmark 
values with the new ones.
 



Windows Benchmarks

Checking Windows performance gives you a much more reliable benchmark for how well 
your system performs because Windows is a very dynamic platform, where change is more 
frequent than in DOS.

To track your Windows performance, select the Windows Benchmarks command in the 
Analysis menu.    When you do, the Windows Benchmarks window appears.    It has the 
following elements:

Standard Results, Prior Results, and Environment
There are three tabs -- Standard Results, Prior Results, and Environment.

The Standard Results tab displays your system’s performance against up to four system 
profiles that are included with WINCheckIt.    These system profiles provide performance 
ratings for various processors such as the 386DX, 486, 486DX, and Pentium.

The Prior Results tab rates your current system’s performance against up to four 
performance ratings from previous multimedia benchmark collects that you have performed 
on your system.

The Environment tab shows system performance results under different Windows platforms 
such as Windows 3.1, Windows 95 with 16-bit accessing, and Windows 95 with 32-bit 
accessing.

NOTE:    There will not be any results posted in the Environment tab for platforms that WINCheckIt did not run under.
For example, if you have not installed Windows 95 yet, there will not be any Windows 95 results.    Likewise, if you 
installed WINCheckIt after having installed Windows 95, then there will not be any Windows 3.1 data.
 
The values that appear under these tabs were calculated using a special weighting scale 
created by TouchStone, which is based on DHRYSTONES and WHETSTONES.
System Component Radio Buttons
WINCheckIt provides performance ratings for five items -- your Overall system, the 
Processor, Hard Drive, Video, and CD-ROM.    Each item is color-coded for easy identification. 
To check the performance of a particular item, select its respective radio button (i.e. for 
Video performance, choose the Video radio button).

Operating System Radio Buttons
The operating system (OS) has a direct bearing on the performance of a system.    Typically, 
Windows 95 with 32-bit accessing operates faster than Windows 3.1.    To gauge the effect a 
particular OS has on a component, use these three radio buttons.    This is a great tool to see
about upgrading to a faster-working OS.

Buttons
There are six buttons in this window:

Select Devices
This button is only active in the Standard Results tab.    Clicking on this button opens a 
Choose Systems window where you can pick which system profiles to compare to your 
system.    The four Current Choices are listed.    To change any of the profiles, use the arrow 
buttons on the right end of the select window.
 
The five radio buttons at the top left of the window let you to assign four comparison 
systems for each component.    For example, if you want to compare systems A, B, C, and D 



for processor performance and systems E, F, G, and H for video, you can click on the 
Processor radio button and select systems A, B, C, and D, then click on the Video radio 
button and choose systems E, F, G, and H.    This feature allows for much greater flexibility in
comparing different systems to yours.

Following this example, when you exit this window and return to the Windows Benchmarks 
window, then select the Processor radio button, system A, B, C, and D will be displayed in 
comparison with your system.    Likewise, when you click on the Video radio button, systems 
E, F, G, and H will appear.

Click on OK to exit and initiate any changes that you made.    Click on Cancel to exit and 
retain the settings that existed when you first entered the window.

Select Dates
This button is only active in the Prior Results tab.    Clicking on this button opens a Load 
window where you can pick which previous collect files to compare to your system.    The 
four Current Choices are listed.    To change any of the profiles, use the arrow buttons on the 
right end of the select window.
 
A radio button in the lower left of the window lets you choose the latest four collects.    Click 
on OK to exit and initiate any changes that you made.    Click on Cancel to exit and retain the
settings that existed when you first entered the window.

Save
This button, which is only active after you have gathered Windows benchmark data and the 
current CKD does not already have that data attached to it, allows you to save the ratings 
information into the currently active CKD file.    The other instance where this button would 
be grayed out is if you have an old CKD file loaded.

Run
Clicking on this button will automatically re-run the Multimedia Benchmark utility and gather
new Windows benchmark data.    This is especially useful if you do something that may affect
your Windows performance, such as closing applications, then want to see the impact that 
that has.

Report
Clicking on this button generates a report of the Windows performance along with all the 
multimedia benchmarks information.
 
Close
Clicking on this button exits the Windows Benchmarks window.
 



DOS Benchmarks

The DOS Benchmarks command allows you to compare the performance of essential system
components with up to nine standard systems and/or with the data from your system from 
different times.    You can print a report of the performance values, and you can save the 
results for use in later comparisons.    Benchmark information is saved in the CKD files when 
you collect data, and in files with an extension of PRF for the standard systems included in 
WINCheckIt. 

Performance is measured by WINCheckIt in three major areas:    performance of the system, 
the hard drives, and the video system.    These are the main components you can use to test 
the performance of your computer and judge its suitability for various tasks.

The Performance Window
Explained below are crucial components of the Track Performance window:

Component List
This allows you to choose the system components for which you wish to view benchmark 
information.

Systems box
Use these radio buttons to toggle between viewing the 10 most recent benchmarks of your 
system, or the benchmarks of standard machines vs. your PC.

Current System
This is the description of the currently loaded data collection file.

Compared To
The description here is either from the data collection file, or from the PRF file supplied with 
standard systems.

Performance Bar Graph
This graph shows the performance data (of the selected type) from the currently loaded CKD
file and up to nine other performance files. The value for the currently loaded file is graphed 
first in the first position.    All of the bars are color coordinated based on the DOS Collect 
Type. Cyan bars represent a windowed box data collection, and mustard depicts Full Screen 
or Drop to DOS data collection.

With all the readings, the higher the bar on the graph ascends, the better the rating.

Changing Performance Files
If you wish to change which systems or versions of your system's benchmarks you are 
viewing, choose the Select button.

NOTE:    You will find different performance results based on the DOS Collect Type. Please see the help section on 
Benchmark Data for more on this.

See Also:
Collecting Benchmark Data 
Selecting Systems to Compare 
Viewing a Benchmarks Report



Collecting Benchmark Data

The benchmark data represented in the DOS Benchmarks window will vary based on the 
DOS Collect Type you use when collecting data.    For the most accurate true Windows 
benchmarks, use the Windowed DOS Collect type.    If you collect data using the Full Screen 
option, you may find that your system's benchmarks are rated up to 50% better. Using the 
Drop to DOS option will create even higher (and possibly misleading) benchmarks.

The bars in the DOS Benchmarks window are color-coordinated to show whether the DOS 
Collect type was Windowed, Full Screen or Drop to DOS.    If you use the Windowed option, 
the bar will be cyan.    Using the Full Screen and Drop to DOS options will be identified with a 
mustard colored bar.



Viewing a Benchmarks Report

Choosing the Report button generates a report containing the performance values for all the 
components of the loaded and selected systems.    You can view, save, or print the report.

The report shows all performance values (but no bar chart) for the current system and the 
comparison system(s).    The report is in a file called PERFORM.RPT in the REPORTS 
subdirectory.    This file will be overwritten the next time you request a Track Performance 
report.    If you want to save the file, use the Save As command on the Report Viewer File 
menu.

The report displays the following elements:

Current System 
This displays the description for the data collect file, which is providing the performance 
data that is being reported.

Platform 
The platform, DOS or Windows, that the data collect file was collected in.

Compared Systems 
Lists the description, filename, and date/time for all the comparison systems displayed on 
the chart.

System Performance 
Your system is compared against either ten previous versions of itself from data collect files 
or ten other PCs, as are listed in the Selected Systems window.    The numeric values for two 
different measurements of system’s main processor and coprocessor, CPUs (Central 
Processing Units) and NPUs (Numeric Processing Units), are displayed along with their 
corresponding ranks.

Hard Drive Performance 
Your system is compared against either ten previous versions of itself from data collect files 
or ten other PCs, as are listed in the Selected Systems window.    The numeric values for 
three different measurements of hard drive performance (throughput, average seek time, 
and track seek time) are displayed along with their corresponding ranks.    Definitions of 
throughput, average seek time, and track seek time follow:

Throughput
This measurement shows how fast data can be transferred from the hard disk.    The 
throughput test reads data from the hard disk and times how long it takes.    The results are 
presented in kilobytes per second (KB/Sec).

A factor that can affect throughput is disk caching.    Disk caching software improves the disk
performance by keeping the data most recently read from the hard disk in memory. The next
time the computer tries to read that data, the cache reads it from memory instead of the 
hard disk.

If you have enough extra memory (e.g., extended memory), you may want to consider 
installing disk cache software.    Depending on the application, this can increase the hard 
disk throughput by more than ten times.

Avg. Seek
This indicates the average time required for the hard drive to move its read/write head from 



one track to another.    The results are presented in milliseconds (ms).

Seek time is the largest single factor in determining the total time it takes to access data on 
a hard disk.    This value is often used to compare one drive to another.

Track Seek
This indicates the minimum time required for the hard drive to move from one track to an 
immediately adjacent track. The results are presented in milliseconds (ms).

Normally, DOS tries to write files on contiguous tracks, making disk operations as fast as 
possible.    When this is the case, the first seek moves to any track on the disk, but 
subsequent seeks would be to adjacent tracks with times similar to the track seek.    
However, as you add, delete, and modify data, files are split into many parts with those 
parts placed anywhere there is room on the disk.

When files become split over time, this fragmentation causes throughput to be diminish 
severely.    Seeks to various parts of the file approach the average-seek time rather than the 
track-seek time.    Thus, the differences in the two access benchmarks will give you an idea 
of the overall penalty you are paying due to fragmentation.    To elevate this problem, use 
products such as Norton Utilities and PC Tools to "pack" the disk, eliminating fragmentation.

The farthest-right columns provide a composite of the throughput, average seek time, and 
track seek time as well as the composite’s rank.    This composite is your checkmark value.

Video Performance 
Your system is compared against either ten previous versions of itself from data collect files 
or ten other PCs, as are listed in the Selected Systems window.    The numeric values for two 
different measurements of video performance, BIOS and Direct video, are displayed along 
with their corresponding ranks.    Definitions of BIOS and Direct video follow:

BIOS Video
This shows how fast the computer can display text data on the screen (in cycles per second 
[CPS]) using the functions provided in the BIOS.    DOS, terminal emulation software, and 
many older programs use this method to display text on the screen.

These ratings can be improved by copying the video BIOS to upper memory RAM (a concept 
called "shadowing").    Consult the manual for your machine and/or video adapter to see if 
your system can be setup this way through its advanced CMOS setup.

Direct Video
This shows how fast the computer can display data directly on the screen.    This method is 
much faster than using the BIOS functions.    Most applications (including word processors 
and DOS shells) display characters this way.    All graphics are displayed using the direct 
method.

WINCheckIt measures video performance in text mode.    However, the relative speed 
measured also applies to graphics.    Higher benchmarks indicate that the machine will likely 
provide favorable performance for CAD programs and Windows.

The farthest-right columns provide a composite of the BIOS and Direct Video values as well 
as the composite’s rank.    This composite is your checkmark value.
 



Find Changes

Using the Find Changes command, you can compare two different sets of data collected at 
different times to isolate changes. The system configuration data compared includes 
hardware and software information.    Specifically, the two data files are examined for 
differences in:

· Hardware components
· Network ID
· Memory usage
· Setup definitions (CMOS, BIOS or IRQ assignments)
· Performance values.
· Operating system version
· Device drivers loaded
· TSRs loaded
· Displays supported
· Setup definitions.

The Find Changes window lists the two configurations and highlights the differences in red.    
You can choose between an Expanded or Compressed version of the comparison data.    

Expanded Version
Shows all values of the compared configuration data for both systems, with the differences 
highlighted in red.

Compressed Version
Shows the differences only.    All the headings are still displayed, but no configuration 
information is listed under a heading if there are no differences in that area.



Setup Advisor

The Setup Advisor allows you to compare the setup recommendations for add-on devices 
and adapter cards to your system’s actual configuration.    The setup items that are 
evaluated include the IRQ Usage, DMA Channels, I/O Port Locations, RAM address space, and
ROM address space.    WINCheckIt comes with a library of over 250 pre-defined product 
setup requirements and you can enter your own specifications as well.

Selecting the Setup Advisor command from the Analysis menu or the Advisor button in the 
toolbar brings up the main Setup Advisor window.
 
The Hardware List on the left side of the window displays the hardware products profiled in 
the database.    This list includes those product profiles that were delivered with WINCheckIt 
in addition to any you may have added yourself.    All of the products are displayed by name 
in alphabetical order.

To select a product to analyze, click on it or use the arrow keys to highlight it. Use the 
Analyze button to determine if the manufacturer’s recommended setup is compatible with 
your system as it is currently configured.

The Manufacturer and name of the Board are displayed in the Board Information area as well
as any notes about the product.

Accessing Detailed Product Information
 Clicking on the Details button brings up the Device Details screen, which contains a series 
of entry fields that describe the primary and alternate assignment requirements of the 
device, including IRQ assignments, DMA channels, and I/O Port addresses, and memory 
addresses.

IRQ Assignment
You can enter up to four IRQ assignments.    Most products however will only have one or two
suggested.    The range here should be between 0-15.

DMA Channel
If the device you are installing requires one or more DMA channels, you can enter the 
suggested assignments here.    Because it is not possible to test for the actual use of DMA 
channels, a standard list is used to compare and suggestions are made for checking 
assignments.

I/O Port Address
Enter suggested I/O Port Addresses in Hex format.    The typical range of I/O Port Addresses is
000h to 3FFh.

Memory Addresses
Enter suggested Memory Addresses in Hex format also.    Up to four memory addresses can 
be specified.

Creating a New Entry
The New button calls up a Board Info screen where you enter the Manufacturer, Board, and 
any notes on the product.    After that, you will need to provide setup requirement 
information that is displayed in the Device Details screen.

Setup Advisor Analysis
Once a hardware product has been selected or a setup entered, use the Analyze button to 



generate an analysis of how the system configuration meets its needs.    The analysis 
window displays Setup Advisor’s summary of the requirements expressed by the main setup 
screen, the availability information for each resource, and a recommended assignment or 
assignment problem description.

NOTE:    You may receive a warning prompt stating that certain collection data (for example, precise settings for the 
I/O ports) is required for a complete anaylsis.    The prompt will recommend a course of action, usually to perform a 
more advanced data collection.

If a recommendation is made, you will be able to see the recommended resources (IRQ 
number, I/O Port Location, or Memory Address) listed immediately above as both 
"Requested" and "Available".    If a problem is cited, the conflicting device may also be noted,
and you will see that the requested resource is not listed among those currently available.    
You may want to refer to the detailed windows for each area to get more information, and 
either move another device or call the manufacturer for additional alternates.

 NOTE:    For best results, make sure you have the most recently collected data file loaded for your machine.

Saving a File Under a Different Name
WINCheckIt comes with a library of hardware product information.    You can supplement this 
library by adding hardware products of interest or adding information about new hardware 
products.

If you want to save any setup information on a hardware product that you entered, use the 
Save As button.    You will be asked to provide a name for the file, which WINCheckIt gives an
ADV extension.

WARNING: Do not save a file as WCHECKIT.ADV under any circumstances.    If you do, you will overwrite the 
WINCheckIt library file with the new file.

You can modify ADV files you have created but you cannot modify the product information 
delivered with WINCheckIt, which is all contained in a single ADV file.

NOTE:    To delete a product you have entered, simply use the Windows File Manager to delete the appropriate ADV 
file.
 



Software Shopper

The Software Shopper allows you to compare the equipment capabilities of your machine to 
the requirements of various software products.    WINCheckIt comes with a library of over 
2,000 of the top-selling software products and their system requirements.

Equipment capabilities checked by the Software Shopper are:

· Processor
· Memory
· Disk space
· Installation media
· Operating system
· Optional devices

Selecting the Software Shopper command from the Analysis menu or the Shopper button in 
the toolbar brings up the main Software Shopper window.

Software Shopper Information
For each software package, the following information can be indicated:

· Software Title--The name of the software package.
· Processor--The processor needed to run the software. 
· Math Coprocessor--A math coprocessor may be required or optional. 
· Operating System--The choices are MS-DOS and Windows. 
· Video--Whether or not video graphics are required. 
· Memory Required--This is the minimum amount of memory (in Kbytes) required to run

the software.
· EMS Required--Whether or not the software requires EMS memory.
· Disk Space--This is the minimum amount of disk space required for the 
· software package.
· Install Media--This identifies the types of media the software in which the software is 

delivered. 
· Network--This identifies the type of network (if any) required by the software.
· Other--This section contains components that a software package might require such as

mouse, joystick, sound card, CD-ROM, modem and Fax card.
· Category--The type of software.
· Sug Retail Price--The suggested retail price of the software package.
· Release Date--The real or projected release date of the software.
· Company--The publisher of the software package.
· Phone Number--The phone number of the publisher.    
· Support Number--Use this number if you have the product and require assistance or 

support.

Software Shopper Buttons
The buttons found on the bottom of the window are as described below:

Close
Closes the Software Shopper window and returns you to the main window of WINCheckIt.

New
Clears the Software Shopper window so you can enter specifications for another software 
package.



Save As
WINCheckIt comes with a library of software product information.    You can supplement this 
library, adding software products of interest to you or adding information about new 
software releases.

Analyze
Generates an analysis indicating where the system configuration matches the needs of the 
software product and where there are problems or potential problems.

Vendor
Brings up the Vendor window, which shows information about the publisher and the 
suggested retail price.

The results from the Software Shopper can be viewed from the Report Viewer, which allows 
you to view, save, and print the report.    The Software Shopper report contains the software 
product information, the purchase information, and the analysis.    

NOTE:    For best results, make sure you have the most recently collected data file loaded for your machine.



Receiving Help

The Help Menu includes the Index of Help Topics, the Reference Library, the applet Version 
screen, and the About screen.

Click on the desired command below for specific help:
Contents 
Search for Help on... 
Reference Library 
Versions 
About 



Help Contents

This Help file contains information about all WINCheckIt commands.    By using the contents 
of this file, you will gain an understanding of all of the programs features.    If you require 
more in-depth discussions or diagrams, or more background information on the commands, 
you may also consider consulting your WINCheckIt manual.

See Also:
Search for Help on... 



Search for Help on...

You can quickly find information in the WINCheckIt Help system by using the Search for Help 
on... command.    This command (and the Search button above) opens the Search dialog box,
where you can select a word for which you want to search.    All Help topics associated with 
the word you select are listed, and you can select a topic to view. For example, to find out 
how to view FAX information, you could select "FAX" from the list. Topics that have the word 
"FAX" associated with them would then be listed in the Search dialog box. 



Technical Reference Library

The Technical Reference Library is a useful collection of PC, DOS, and Windows reference 
material.    The library comes in two parts:    TouchStone's Reference Guide and the four-
volume set from McGraw-Hill, which includes Upgrading & Repairing Your PC, DOS Made 
Easy, Windows 3.1 Made Easy, Windows 95 Made Easy.

To access the Technical Reference Library, click on the Refernc (Reference) button in the 
toolbar on the main window.    The Reference Library selection screen will appear where you 
can choose which part of the library you want to open.

To open one of the four McGraw-Hill books, the CD-ROM that is included with WINCheckIt 
must be loaded in your CD-ROM drive.    Once the CD-ROM is in the drive, you can click on 
the button for the respective book that you want to view.

TouchStone's Reference Guide was written in a Windows help file format.    Like this Help file, 
topics in the reference library can be found by contents or by searching for a specific 
keyword.    As a result, you can open the guide without the CD-ROM being present in the CD-
ROM drive.

Click on Cancel to exit the selection screen.

See Also:
Search for Help on... 



About

Selecting the About menu option will display information about WINCheckIt, including: 
Version number, copyright and licensee details, serial number, 6-character user ID, the 
Windows operating mode, and the amount of free memory available to Windows.



Loopback Plugs

When running diagnostic tests from a command line, WINCheckIt provides the option to use 
loopback plugs when testing serial and parallel ports.    To use loopback plugs during testing, 
you must specify that you are using the plugs with the /T:l option.    (For more help, type /? 
after the test name, i.e. CKLPT /?).        The parallel loopback plug can also be used during the
view IRQ procedure for more accurate results.    Look in the Reference Library for diagrams of
the loopback plugs if you wish to build them, or contact TouchStone to buy them.

See Also:
Serial Port Testing 
Parallel Port Testing 
IRQ/DMA Analysis 



A peripheral is classified as any external device attached to and controlled by a computer's 
CPU (Central Processing Unit).      



Real Mode is a type of PC operation where a program is given a specific storage area    in 
memory, and direct access to peripheral devices.    This mode can cause problems when 
more than one program is loaded into memory at one time.    Programs loaded 
simultaneously in this mode can crash the system as they will try to share the same memory
area.    Using protected mode instead will solve this problem.



To solve the problems of Real Mode, where programs loaded simultaneously try to share the 
same memory area, Protected Mode was created, which prevents such interference.      
Programs can be successfully loaded simultaneously in Protected Mode, which allows for 
multi-tasking.    



An Interrupt ReQuest is an assigned value which controls instructions for hardware and 
software.    Each device must have its own IRQ, or a conflict will occur.    The CPU uses these 
IRQs to determine which devices are calling with input or output.    WINCheckIt will display all
devices and their IRQs.    



Described in hexadecimal format, I/O (Input/Output) assignments describe the channels in 
memory by which devices and the CPU communicate.    Each device will have its own unique 
I/O address.



In MS DOS versions 5.0 and 6.0, you can load DOS into the High Memory Area (HMA) to allow
more room in base memory for other programs.    The line DOS=HIGH,UMB should be added 
in your CONFIG.SYS file.



Terminate, Stay Resident programs are loaded in to memory, and then are not visible until a 
specific keyboard combination (a.k.a.    hotkey) is pressed.    You can use the WINCheckIt TSR 
map to see which TSR programs you have loaded, where they reside, and how much 
memory they are taking up.    Common TSR programs are:    DOSKEY, popup calculators, and 
E-Mail packages.



The Buffers= command in the CONFIG.SYS file specifies how many disk buffers are available 
when a PC boots.    The buffer stores information from disk in memory, making access to 
information faster.    Too many buffers set can slow your system by using too much memory, 
and too few buffers set can cause conflicts with certain programs.



The LASTDRIVE= command is located in the CONFIG.SYS file and dictates the total number 
of drives that can be activated.      



The DEVICE= command is located in the CONFIG.SYS file, and is a device driver loading 
command.      For example, DEVICE=MOUSE loads the device driver needed for the system to
use a mouse.    Each device will have its own specific device driver.



Installing Devices

Before you install a new device to your PC, there is a set of information that you need to 
know to avoid a conflict in configuration including IRQ, I/O Port Address, ROM Address, DMA 
Channel and Memory Address. The Setup Advisor will help you make the right decisions 
about how to set up a new device so that it works right the first time.    You can even check 
to see if the recommended setup will work without conflicts, and if not, the Setup Advisor 
recommends alternate setup assignments.

See Also:
Setup Advisor 



Naming Convention of COM Ports

IBM PCs and compatibles have four standard base addresses for serial ports. These 
assignments are as follows:

· 3F8H --    (Port 1)
· 2F8H --    (Port 2)
· 3E8H --    (Port 3)
· 2E8H --    (Port 4)

The BIOS assigns port indexes in the order in which it finds the serial ports on the machine.   
It searches for the ports by base address, proceeding in the order indicated above.    DOS 
assigns COM 1 to the first port it finds, COM 2 to the second and so on.    If you have a 
machine with two COM ports, one at 3F8H and IRQ 4 and the other at 3E8H and IRQ 4, then 
DOS would call them COM 1 and COM 2. The address 3F8H would be COM 1 and 3E8H would
be COM 2.

WINCheckIt shows the COM names assigned by DOS.    Communications software commonly 
do not use the COM names assigned by DOS.      Therefore, WINCheckIt and a 
communications package may call the same port by different names. The most important 
information is the actual base address and IRQ.

Windows addresses the COM ports in the same manner as DOS, but the Windows COMM.DRV
may be confused when a COM address is skipped over.    It expects certain COM ports to be 
addressed in the order shown above. To compensate for a missing COM address, you can 
add a NULL port to the SYSTEM.INI file.    For example, to skip over the second port address, 
you would add the following lines to the [386Enh] section of your SYSTEM.INI file:

COM2IRQ=-1      (This disables the false COM 2 appearing in the BIOS data area)
COM3Base=03F8      (This sets the correct COM 3 address)
COM3IRQ=4      (This sets the correct COM 3 IRQ)



Files with a PRF extension performance files for standard systems.    WINCheckIt installs a 
group of these PRF files to the PRF subdirectory when you run the setup program.      



32-Bit Disk Access

What Is 32-Bit Access Mode?
Thirty-two bit access works as a device driver that communicates with the hard drive 
controller.    This function looks for specific hardware interrupts (13H), and handles them 
directly, thus replacing the disk BIOS.

During installation, the Windows Setup program determines if your hard disk controller can 
use 32-Bit Access (although we have seen on some systems determination is incorrect).    If 
your machine has the ability to use 32-Bit Access, a check box in the Virtual Memory dialog 
window will be available.      Using 32-Bit Access increases the hard drive access time, and 
allows for more (and quicker) instances of the MS-DOS Prompt.    You can manipulate the 
settings for 32-Bit Access in the Windows Control Panel.

The Need to Disable 32-Bit Access
Due to the manner in which 32-Bit Access manipulates the hard drive controller, some 
machines cannot handle programs that write back to the hard disk.    If you experience 
difficulties using WINCheckIt* and other programs, try disabling 32-Bit Access mode.

For more information on this, please consult your Windows manual.

* WINCheckIt's Collect command and its tests make write back to the hard drive in such a manner that may cause 
problems if your machine has been setup to use 32-Bit Disk Access.



Running Applets From DOS

The tests in WINCheckIt Professional may be run from the command line in DOS.    Each test 
is its own applet with a file name starting with "CK,"    and continuing to describe the test 
(e.g. CKSYS.EXE is the system board test).    For help on a specific applet name, type the 
filename followed by /?.    



An applet is a mini-application.    All the WINCheckIt tests are applets as is CKDATA.



The CKDATA, WCKDATA, CMDATA, & CKDATA32 Programs

WINCheckIt uses four mini-applications (applets) -- CKDATA for DOS, WCKDATA for Windows, 
and CMDATA and CKDATA32 for Windows 95 -- to collect specific system and configuration 
information about your PC. Data collection takes between one and two minutes, depending 
on your system’s configuration. The data is stored in a binary file with .CKD extension. This 
binary file can be interpreted by WINCheckIt and other TouchStone products.

These programs are launched automatically when you use the Collect Data command.    



CKD Files

WINCheckIt collects system configuration and performance data and stores it in a file with 
the extension "CKD."    In the manual and this help system, these files are referred to as CKD 
files.    In addition to collecting data from your own PC, you can also collect data about other 
systems using the several applets provided with WINCheckIt.    Running the CKDATA applet 
on a machine where WINCheckIt is not installed will carry out the same function as selecting 
the Collect Data command under the File menu.

See Also:
Collecting Data 
The CKDATA, WCKDATA, CMDATA, & CKDATA32 Programs 



Direct Memory Access (DMA)

By using Direct Memory Access, or DMA, components on your computer can transfer 
information without passing it through the CPU.    Avoiding the need to send data through the
CPU saves a considerable amount of time.    DMA is used mainly for transferring data to and 
from hard disks, but is often utilized by backup programs to improve speed by directly 
transferring data from the hard disk to floppies.    This process is controlled by the DMA 
controller chip.    PC and XT class machines have one DMA controller chip, and AT and later 
class machines have two.

DMA Availability
Unlike detecting IRQs assignments on a PC, channels used by DMA are not available.    
Devices only occupy a DMA channel while in use, whereas IRQs are assigned more 
permanently (although they can be changed manual).    Common DMA channel assignments 
for are PC and AT type machines are shown below:

PC and XT compatible machines:
DMA0 Used by system (not available on bus)
DMA1 *
DMA2 Floppy disk controller
DMA3 Hard disk controller

AT compatible machines:
DMA0 Used by system    (16 bit)
DMA1 *    ( 8 bit)
DMA2 Floppy disk controller      ( 8 bit)
DMA3 *    ( 8 bit) 
DMA4 [CASCADE] - Slave DMA controller input into master
DMA5 *    (16 bit)
DMA6 *    (16 bit)
DMA7 *    (16 bit)

 * = No standard DMA assignment; you can assign these DMA channels to devices not listed 
that can be configured for DMA.

Testing the DMA Controllers
In the System Board test, WINCheckIt checks to see that communication between your CPU 
and the DMA controller is functioning properly. If there is a failure, either your DMA 
controller, or the CPU is not working correctly.    The System Board Test will automatically 
check both.    Each channel and register is checked, and the refresh function is tested.    
Problems with the refresh cycle can cause what might otherwise appear to be memory 
errors.



Clean & Zip
 
The Clean & Zip utility allows you to delete unwanted files from a drive, cleaning up any 
duplicates, empty files, and other clutter that may exist.    You can select any floppy drive, 
hard drive, or network drive (including local drives on other people's systems if you are 
running a peer-to-peer network such as Windows for Workgroups) seen by your system.

For more information, please refer to the help file that accompanies the actual Clean & Zip 
program.

See Also:
Deletion Log 



Tune Up

The Tune Up command consolidates Windows free memory fragments to increase the size of 
the "largest memory block available."    This is important if you want to run a program that 
cannot find a single memory block large enough to complete loading or printing.

The Largest Memory Block Available is the largest physical memory block Windows can 
retrieve not including swapfiles or other types of virtual memory.    The Tune Up function 
should positively affect the size of the Memory Block.

The Tune Up utility may be accessed one of three ways:    using the Tune Up button on the 
main window, selecting Tune Up from the Realtime menu, or clicking on the Tune Up icon in 
the WINCheckIt Program Group.

Notice that when you use Tune Up, the Largest Memory Block Available bar graph    on 
WINCheckIt's main screen increases.    This helps keep your system from running out of 
memory when trying to install an application.    In addition, if your system seems to be 
running slower, try the Tune Up utility to improve performance.



Uninstalling Applications
 
The Uninstall utility allows you to get rid of unwanted applications.    The Uninstall utility may
be accessed one of three ways:    using the Uninstall button on the main window, selecting 
Uninstall from the Realtime menu, or clicking on the Uninstall icon in the WINCheckIt 
Program Group.

For more information, please refer to the help file that accompanies the actual Uninstall 
utility program.

See Also:
Deletion Log 
 



Creating a Rescue Disk 

The Rescue Disk command on the Realtime menu is an invaluable tool for preserving your 
DOS and Windows system settings in the case of a system crash.      You can use the Rescue 
Disk command from inside WINCheckIt to save your DOS and Windows settings, and the 
DOS-based RESCUE.EXE program to restore those settings. 

The Rescue Disk and Loaded Data
Before you use the Rescue Disk command, we strongly suggest that you collect data on your
machine.    If you have recently collected data and have not made any changes to your 
system's configuraton, then simply load the most recent data file.

Creating a Rescue Disk
It is a very easy and quick task to create a Rescue Disk using WINCheckIt.    Select the 
Rescue Disk command from the DOS/Win menu.    The Rescue Disk automatically saves a 
copy of thefollowing systems files:

· COMMAND.COM -- The main program file for DOS, COMMAND.COM contains the 
command processor and internal commands such as DIR, COPY, and MD.    It is 
important that you do not have different versions of COMMAND.COM on your system.    
To check this, look at your DOS and root directories for any variance.

· WIN.COM -- The main program file for Windows, WIN.COM is modified as you make 
changes or updates to Windows.    If you have to re-install Windows without a backup of 
your present WIN.COM, you may have to make configuration changes manually. 

· All other INIs -- Selecting this check box will save all of the INI files found in the 
Windows directory.    Many Windows programs store their INI files in the Windows 
directory.    By saving these INI files, you will be able to keep your applications finely 
tuned the way you like them.

· IFSHLP.SYS -- This file, which will be available for Windows for Workgroups users, 
handles advanced features such as 32-bit disk access.    Without this file present, 
Windows for Workgroups may not load.

· Program Groups (.GRP) -- By saving the .GRP or Program GRouP files, you will be able
to restore the custom groups you have in Windows, even if you have to re-install 
Windows to solve a problem.    Without these GRP files, re-customizing your Windows 
can be a painstaking and frustrating task.

· Enhanced Mode (.386) -- If your Windows is set up to use 386 Enhanced Mode, there 
will be several files with a .386 extension on your root and Windows directories.    
Enhanced Mode allows your applications to run faster by accessing virtual memory, or 
more memory than is actually available on your system through use of your hard disk.

· Current Drivers (.DRV) -- When this group of files is selected, the Rescue Disk 
command will save all of the drivers currently used by Windows and related devices.    
By referencing the SYSTEM.INI file, WINCheckIt is able to save only the drivers you are 
currently using, thus economizing space on the Rescue Disk. 

· Video Support (.?GR) --The 286 grabbers (.2GR) are used for standard mode only and 
support PrintScreen, and copying and pasting text between Windows-based applications
and MS-DOS-based applications. 386 grabbers (.3GR) support Windows 386 enhanced 
mode provide the following:    Copying text from MS-DOS-based applications, displaying 
and selecting data in a windowed virtual machine, copying graphics to the Windows 
Clipboard, and PrintScreen. 

 NOTE:    A copy of the currently loaded systems files will be saved to the Rescue disk automatically.

Rescue Disk and Loaded Data
Before you use the Rescue Disk command, we strongly suggest that you collect data on your



machine using the Collect Data command from the startup options or from the Collect Data 
command on the File menu (for more details on data collection, see Collecting Data).

If you have not recently collected data, you will receive a warning dialog when you select the
Rescue Disk command.    If you have recently collected data and have not made any changes
to your CMOS setup, then select Continue.    Selecting Cancel will end the rescue disk 
function.

If the most recent CKD file on your system does not contain all the necessary system files to 
ensure a proper rescue, you will receive a second warning with the message "The currently 
loaded CKD is missing system information.    We recommend you perform a new Collect Data
(from the File menu) before continuing."    If you choose to continue, WINCheckIt will get the 
missing information and continue to the Rescue Destination screen.

Specifying the Rescue Disk Destination
The first step in the process is for WINCheckIt to compress the proper files into a single 
compressed file that you can restore later.    You must choose where to put the compressed 
file.    Your options are either a floppy drive or other location (e.g., a hard drive).    Keep in 
mind, if you choose floppy disks, the compressed file may take more than one disk.

After selecting where you want to place the compressed rescue file, WINCheckIt asks you 
where you want to save the rescue file.    Choose a destination for the compressed rescue file
and click on OK.

If you are creating a rescue file on a floppy disk, make sure it is a bootable disk.    For more 
information on creating a bootable disk, consult Windows help or its manual.    If you do not 
insert a bootable disk, you will receive a warning.    You can either go back to the previous 
step using the Back button (to select a different location where save the rescue file), 
continue the process using the Ignore button, or make another attempt to create a rescue 
disk with a different floppy using the Retry button.

If you continue the process without inserting a bootable disk (that is, one that is properly 
formatted, but without the necessary files to boot), understand that the rescue disk you 
create will not be bootable.

When the rescue file is created, you can see which files are compressed as they are copied 
to their destination.    If a second floppy disk is required, a prompt will request that you insert
another disk.    When the process is complete, the message "Rescue Created Successfully" 
will be displayed.

For a detailed list of which files are rescued, refer to WINCheckIt’s on-line help system.

In cases where there is insufficient disk space to save your Rescue Disk contents, you must 
choose a different location to save your compressed rescue file.

NOTE:    It is always a good idea to store the Rescue Disk data on another drive than the one where Windows is 
installed, just in case that drive crashes.    Once the Rescue Disk is created, the temporary file created in the TSC\
WINCKPRO\DATA directory will be deleted.    Keep in mind, if you are creating a Rescue Disk on the drive where 
WINCheckIt is installed, you must actually have twice the disk space available for the Rescue Disk until the 
command is completed.

See Also:
Restoring with a Rescue Disk 





Deletion Log

The Clean & Zip and Uninstall utilities will help you delete files and program items off your 
PC's drives.    To help you keep track of exactly what has been removed by these two 
commands, a record is added to the Deletion Log each time you use the delete function for 
either command.

The Deletion Log (named WCHECKIT.LOG) can be viewed by selecting the Deletion Log 
command from the File menu.    The log is limited to 30KB in size.    Once your log has grown 
to 30KB, the oldest data will be moved out of the log to make room for new data.    You may 
want to view the size of the Deletion Log from time to time, and save it to another name if 
keeping a permanent and all-inclusive log is necessary.



Versions

This screen provides the version and size of the WINCheckIt applets (mini-applications).    
Because these applets are separate programs, TouchStone can implement new technology 
into the WINCheckIt set of programs more easily.    This way, if you run into a problem with a 
new device or software package, you can download an enhanced version of the applet you 
need from our BBS or CompuServe forum.

In addition, it is very useful to know the version of the different applets for troubleshooting 
purposes should you need to contact our Technical Support.

NOTE:    For help with any of the diagnostic applets, type their name followed by "/?."



Resource Report

The Resource Report command in the Analysis menu allows you to find out exactly what is 
setup on your computer.    The Resource Report is thorough and concise so you do not have 
to wade through pages and pages of information.    The report is a compilation of the System
Summary on the main window and critical setup analysis information taken from the Setup 
Advisor analysis.

View Area
At the top of the report, the following items are displayed: WINCheckItfessional version; 
licensee (you); the data collect file name, time collected, and description; and the date you 
requested the report.    The report itself is separated into two main parts--the Configuration 
Summary and the Configuration Setup Analysis.

· Configuration Summary -- The information displayed under this heading is identical to
the System Summary provided on the main window.    

· Configuration Setup Analysis -- The information displayed under this heading 
provides a concise summary of IRQ and DMA Channel usage, I/O port availability, and 
Memory Address and ROM Locations.    If there are any problems (e.g., a device without 
an IRQ), the analysis will tell you.

Buttons
The following buttons are available on the Resource Report screen:

· OK -- Closes the window
· Print -- Sends a copy of the Resource Report to your printer



Exclusions

It is highly uncommon -- but possible -- for WINCheckIt to experience a hardware 
incompatibility problem when collecting data.    This is due to the millions of different 
combinations of hardware and software available.    Such an incompatibility may cause the 
data collection process to "hang" your computer.

NOTE:    One way to tell if your system is hung is to toggle the CAPS LOCK key to see if the light on the keyboard 
changes.    If the light does not change, your system is hung; if it does change, then the system is not hung.

If you use the Collect Data command and your PC hangs, check the data-collection-progress 
window to see which component was last queried before the data collect failed.    Excluding 
this data collect may solve the problem.    

NOTE:    If you experience the hanging using the Advanced collect options, try the Standard collection method 
before an exclusion. 

An important point is:    If you run a data collection using the Custom method in intelligent 
mode, you will never need to worry about excluding collects if a data collection fails because
the intelligent mode will record any collects that fail and exclude them automatically when 
you perform sebsequent data collections.    If you perform a data collection using the 
Minimum or Advanced method in intelligent mode and it hangs, WINCheckIt will exclude the 
failed collect for the next data collection only.

An Example...
Let's say you run a data collection and it hangs on IRQ detection.    Go into the Collect Data --
Custom Settings window and exclude the IRQ collect.    Try running the data collection again 
to see if it now works.    In most cases, the data collection should now work without 
problems.



Selecting Systems to Compare

Pressing the Select button on the DOS Performance window allows you to choose a 
system(s) to add to or subtract from the Selected Systems list.    

Select Comparison Systems Window
On the left side of the Select Comparison Systems window is a list of Available Systems, from
which you may select for addition to the DOS Performance bar graph.    As you highlight 
different system files the description below the Available Systems list changes.    On the right
side of the window is a list of up to ten Selected Systems that appear in the Track 
Performance bar graph.

Changing Selected Files
There are three buttons (<<Remove, Insert>>, and <<Switch>>) for moving files back and 
forth between the Selected Systems and Available Systems lists.    These three buttons 
located in the middle of the window allow you to select individual files to move between the 
Available Systems and Selected Systems lists.

· <<Remove -- If you simply want to remove a file from the Selected Systems, highlight 
the appropriate slot, then click on the Remove button.

· Insert>> --If the Insert button is selected, the file highlighted in the Available Systems 
list is placed into the slot highlighted in the Selected Systems list.    If there is a file in 
the slot, that file is bumped to the slot below and all the subsequent files are bumped 
down one position.    In this case, if there were no empty slots to fill by the bumped-
down files, the tenth file would be bumped off the Selected Systems list and returned to 
the Available Systems list.

· <<Switch>> -- The Switch button swaps a highlighted Available System file for a 
Selected System file.



Restoring with a Rescue Disk
When the inevitable time comes and you need to restore some or all of the files on your 
system, the first step is to locate the Rescue Disk you created previously.    While the 
creation of your Rescue Disk was done in Windows (from the Realtime menu), you will 
restore your files using the DOS-based RESCUE.EXE program, which is located on your 
Rescue disk.

To run the RESCUE program, change to the drive (and directory if applicable) where the 
Rescue disk was created and type:

RESCUE [Enter]

After select the Restore button, you will be prompted with a standard open file dialog box 
where you will identify the path of your Rescue file.    After you select the Rescue file (named 
RESCUE.WCK), the RESCUE program will take a quick survey of the files stored in your 
Rescue Disk, and then allow you to make choices as to which files you would like to restore.

By default, the check boxes for all available options will be selected.    Any unavailable 
options (because the item was not collected), such as PROTOCOL.INI for non-Windows for 
Workgroups users, will be grayed out.    To select or de-select an option, tab to that option 
and press the <Space> bar.

When you have selected and de-selected the files you wish to restore, press the Restore 
button.    If you have selected files to be restored to your WINDOWS or WINDOWS\SYSTEM 
directories, you will be asked to specify your Windows path.    If you are only restoring DOS 
files or the CMOS table, you will not be asked for this information.    

After typing in the path for Windows (if applicable), the RESCUE program will begin restoring 
the files you have selected.    You will see a progress indicator, showing you which files are 
being copied and how far the process is toward completion. When all of the selected files 
have been restored, RESCUE will return splash screen, where you can select the Restore 
button to choose other data to be restored or Cancel to quit.



When used in this context, the term "safest" refers to a data collection that will not cause 
your PC to hang.    Using more advanced methods may cause problems, and therefore aren't 
suggested for your first pass at data collection.



DOS Collect Type
Options for the DOS-based data portion of the collection routine include the following:

· Windowed --    This is the default and most-true Windows data collection.    By collecting
from Windowed DOS box, the data will best reflect your PC's state (drivers loaded, ports 
labeled, and memory configuration, etc.) while Windows is in use, whereas a Full Screen 
and Drop to DOS collect will not.    This is the best type of collection to select when 
looking for true Windows benchmark results.    Using the other DOS Collect types will 
produce very different results. 

· Full Screen -- Although the "Windowed" DOS Collect Type is most desirable, you may 
find that using the Full Screen environment is necessary in conjunction with the 
Advanced Method options.    Try using this method only after the Windowed environment
does not behave properly with Advanced or Custom collection methods.

· Drop to DOS --    If you select this collection environment, WINCheckIt will close down 
Windows before a collection is started.    Note that data from this collection will reflect 
your PC's state as a DOS only machine.    After data collection, Windows and WINCheckIt 
will be restarted, however, any other programs open at the time you started this 
procedure will not be restarted.    

NOTE:    The Drop to DOS Collect Type will only be necessary if the Windowed and Full Screen options do not 
function properly.



Accessing TouchStone Technical Support

Selecting the About command from the Help menu accesses the About screen, which 
includes TouchStone contact information, version numbers for the main WINCheckIt program
and the CKDATA & WCKDATA applets, and license information (name, company, and serial 
number).

About
Versions

For more information about contacting TouchStone's Technical Support, see Contacting 
Technical Support.

Click on the OK button to exit the About screen.

See Also:
CKDATA & WCKDATA



Contacting Technical Support

Striving to offer our customers the most comprehensive support available, we offer several 
methods you may receive support.    The options are listed below.

Complimentary Warranty Support
TouchStone Software provides users support during the time period proven to be the most 
critical;    for ninety (90) days after the first service call or a maximum of ninety (90) days 
from the registration date.    This support is available at (714) 969-7746 or (714) 374-2801 
from 8:00 am to 5:00 pm Monday through Friday for all currently published software 
products to all customers who have registered their products.
    
Free Unlimited Support
"Free Unlimited Support"    is provided to all registered users of any published software 
through one of our on-line services.

CompuServe 74431,1125 GO TOUCHSTONE
America On-Line GO TSCTECH
TSC Bulletin Board    (714) 969-0688
Internet Web Page http://www.checkit.com

TouchStone will strive to respond within one (1) business day.

Out of Warranty Support
TouchStone Software offers support after the complimentary warranty period to users for 
any of their published software on a chargeable basis.    Users have the option of calling 
(800) 859-1763 using their    Visa/MasterCard/American Express to receive support at 
$2.00/minute U.S. rate.    Registration is recommended, but not required for chargeable 
service.    Registered users may also use one of TouchStone’s online services for support at 
no charge.    (See Free Unlimited Support)

Extended Service Support
TouchStone Software is located in the Pacific Time Zone.    Because users often require 
support after-hours/holidays/weekends, TSC offers technical support on a chargeable basis. 
Users have the option of    calling (800) 859-1763 using their Visa/MasterCard/American 
Express to receive support at $2.00/minute U.S. rate.    Registration is recommended, but not
required for chargeable service.

Expedited Service
Technical support is given on a first call-first served basis.    For convenience, users that 
demand immediate, expedited response    have the option of calling (800) 859-1763 to 
receive support at a chargeable rate of $2.00/minute U.S. rate using their 
Visa/MasterCharge/American Express. Registration is recommended, but not required for 
chargeable service.

Out of Date Product Support
To obtain real-time support on products which TouchStone no longer publishes or products 
replaced by a newer version., users have the option of calling (800) 859-1763 using their    
Visa/MasterCard/American Express to receive support at $2.00/minute U.S. rate.    
Registration is recommended, but not required for chargeable service.    Registered users 
may also use one of TouchStone’s online services for support at no charge.    (See Free 
Unlimited Support)



Removing WINCheckIt From Your System

The Removeit Program makes it easy for you to remove part or all of the WINCheckIt 
application from your system.    You’ll find the program in the WINCheckIt Program Group in 
Windows.    In Windows 95, you can find WINCheckIt in the Add/Remove Programs area.

After clicking on the Removeit icon, you’ll see the Removeit Copyright screen where you can 
proceed with or cancel the operation.    To continue, click on the Proceed button.

You will be asked to specify what parts of WINCheckIt that you want to remove.    The default 
is that all are selected to be removed.

WARNING:    Be careful not to delete your data collect files if you plan on re-installing WINCheckIt.    Otherwise, you 
will lose them in the removal process.

All the parts of WINCheckIt except Uninstall Archive Files are selected by default to be 
removed.    If you select Main Files, Removeit will remove all the icons from the WINCheckIt 
Group then the group itself.    To go on with the removal process, select the Continue button.  
A progress indicator will display how far along you are in the removal process.

If, for some reason, Removeit does not work, check for a valid WCHECKIT.INI file.    If this file 
is missing, Removeit will not work.

Removing Removeit
The Removeit program does not remove itself -- you need to delete it manually.    If you have 
used Removeit to delete WINCheckIt and its corresponding files, the Removeit program will 
reside by itself in WINCheckIt’s PROGRAMS directory (the default when installing was TSC\
WCHECKIT\PROGRAMS).

To delete Removeit, go to the PROGRAMS directory and, at the DOS prompt, type delete 
checkout.exe, then press [ENTER].    Removeit will be deleted.

To delete the remaining directory tree, go to the root directory by typing cd\ [ENTER].    Once 
you’re at the root, type the command deltree tsc\wcheckit\programs, then press [ENTER].    
That will remove the directory tree.
 



Frequently Asked Questions -- FAQs

Listed below are five categories of questions that have crossed TouchStone's help desk.    
Reviewing these questions and answers may help you quickly solve a problem.

Installation Questions
Execution Questions
Data Collection Questions
Reporting Questions
Clean & Zip Questions



Installation Questions

The following questions and their answers pertain to the installation of WINCheckIt.    They 
are in no particular order.

Q: I received the message "INST30 caused a General Protection Fault in Module 
IS_0433._M" when installing WINCheckIt.    Why?

A: This error can be caused by either high resolution video driver or by a bad diskette. 
To decide which is at fault, change the video driver Windows is using to the standard 
VGA driver, and close any video card specific program running (i.e. Number 9’s 
Control program) and retry the installation. If the error re-occurs under the standard 
VGA driver, return the package to place of purchase for an exchange.

 
Q: While trying to install WINCheckIt, I get to the point where SETUP asks for the second 

disk and I get the error "SETUP could not find a file on the specified path or disk." 
What is wrong?

A: This error indicates a problem with disk changes, to verify, exit from Windows to the 
DOS command line. Put the first diskette in the drive and type DIR A: (or B: if that is 
your 3 1/2" drive), then remove the disk #1 and replace it with disk #2, and type DIR 
A: (or B: if that is your 3 1/2" drive) again. If directory listing displayed is the same as 
disk #1, please contact your computer repair technician.

 
Q: When I install the TouchStone CD and it gets to the point where ACROREAD installs I 

get the error message: "not enough free disk space to continue installation."
A: Perform the following two steps:

1) Make sure there is at least 4 to 8MB of free disk space on the hard drive where 
Acrobat Reader is being installed.

2) Make sure the "SET TEMP=" in the AUTOEXEC.BAT file is set to a valid path and 
directory.    Also, that there is enough disk space where the TEMP directory is and 
there are not too many files in the TEMP directory.

 
Q: I’m trying to install WINCheckIt and I keep getting the error message "Setup is unable

to decompress and copy all the program files needed to proceed with the installation.
Contact your software vendor.    ERROR 112."

A: At the DOS command line, type SET and hit the ENTER key.    Find the variable TEMP 
in the list and check to see that it is set to a valid drive and path (directory must 
exist).    Then check the TEMP directory, if there are a lot of files in it, delete them and
retry the installation.

 



Execution Questions

The following questions and their answers pertain to the installation of WINCheckIt.    They 
are in no particular order.

Q: When trying to access WINCheckIt in Windows 95, I get the error "THIS APPLICATION 
HAS PERFORMED AN ILLEGAL OPERATION AND WILL BE TERMINATED."      Then I get a 
"PAGE FAULT ERROR."

A: Run WINCheckIt from safe mode (by pressing the F5 key when the words "Starting 
Windows 95" appear while the screen is black). If WINCheckIt runs fine, we’ve 
determined there may be a problem with your Windows 95 setup, we suggest you 
contact Microsoft Windows 95 Tech Support at (206) 635-7000.

 
Q: I installed WINCheckIt and ran a minimum collect.    Now, whenever I start 

WordPerfect for Windows I get an error "WIN2WRS CAUSED A GPF IN ATM32.DLL."    
Then I get a message stating that there’s not enough memory or hard drive space to 
continue and some of my fonts are missing.    What did WINCheckIt do to my system?

A: Remark out the lines in ATM.INI that have ACROREAD in them (they should be at the 
end of the file).

 
Q: When I click on the CD-ROM button, I get an error message: "Sub or function not 

defined."
A: Rename the file MSVIDEO.DLL in the WINDOWS\SYSTEM directory and reinstall 

WINCheckIt to load a newer version of Msvideo.
 
Q: The CD-ROM test produces the error: "The file C:\WINDOWS\SYSTEM\THREED.VBX is 

out of date."
A: The CD-ROM test requires a newer version of    the threed.vbx file.    Rename 

THREED.VBX to THREED.OLD in the WINDOWS\SYSTEM directory.    Copy the file 
THREED.VBX in the TSC\WINCKPRO\PROGRAMS directory to WINDOWS\SYSTEM 
directory.

 
Q: Under WIN95, when I try to run the Multimedia Benchmark, I get an error "Unable to 

open AVI?"    If I hit the OK button, the benchmark continues running except the 
benchmark window is blank.

A: Check to ensure that you have the following files in the WINDOWS\SYSTEM directory:
AVIFILE.DLL MCIAVI.DRV
COMPOBJ.DLL MSACM.DLL
DISPDIB.DLL MSACM.DRV
ICCVID.DRV MSVIDEO.DLL

 
If the files are not there, install Multimedia Support from your Windows 95 install 
media.    If the files are there, we suggest you contact Microsoft Windows 95 Tech 
Support at (206) 635-7000.

 
Q: After selecting the hardware changes detected button, I receive an error "WCHECK4 

caused a general protection fault in WINCHECKIT."
A: Delete the .CKD files located in the TSC\WINCKPRO\DATA directory that    were from 

incomplete collections.    These collections will not show up on the list when you 
select the Load button after selecting NO DATA.

 



Data Collection Questions

The following questions and their answers pertain to collecting data in WINCheckIt.    They 
are in no particular order.

Q: My WINCheckIt used to collect data fine, but now it hangs just after the message 
"Transferring to CKDATA," the CKDATA window comes up, but it's blank with a cursor 
in the upper left corner.

A: Delete the WCKDATA.INI file located in the Windows directory. The file is corrupt; it 
will be created the next time the data collection is performed.

 
Q: When I run a collection with WINCheckIt, I get the error: "THIS APPLICATION HAS 

PERFORMED AN ILLEGAL OPERATION AND WILL BE SHUT DOWN." My video card is a 
Cirrus Logic GD-542x or the GD-5430.

A: Call Cirrus Logic’s BBS at 510-440-9080 to download the latest drivers. This is a 
suggestion from Cirrus Logic, makers of    the chip set for these particular video cards.
If you feel you have a bad card, we suggest contacting the vendor from whom you 
purchased the card.

 
Q: When I do the collection, when WCKDATA shows "CHECKING FOR COM PORT X," my 

screen goes black and I have to reboot.
A: Change the video driver to the Windows standard VGA and see if the collection will 

work.    ATI Mach 64 video cards will experience a monitor power down when 
WCKDATA hits COM4.    The collection will continue however, but since there is no 
video display, the system appears locked up.

 
Q: Sometimes collect will hang at "WCKDATA Checking COM1," other times it will hang 

at other points. Rarely does it complete correctly. What is happening?
A: Battery watch programs running in Windows can cause this.    Make sure the only 

thing on the TASK LIST is PROGRAM MANAGER.
 



Reporting Questions

The following question and its answer pertains to the data reporting in WINCheckIt.

Q: The collection did not detect my modem on my Toshiba notebook.
A: Ensure that there is a card service driver for the PCMCIA modem card in the 

AUTOEXEC.BAT file and that the driver is the latest version.
 
 



Clean & Zip Questions

The following question and its answer pertains to the Clean & Zip utility.

Q: When I re-label my disk the old label name, it still shows up when I run CLEAN & ZIP.
A: If the label is changed in the Windows File Manager, CLEAN & ZIP will not reflect the 

change.    Change the label from the MS-DOS command line.
 






